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Unpacking and Inventory

1.0 Receiving and Inspecting the Repeater

When you receive a repeater from Repeater Technologies, Inc. (RTI), immediately do the
following:
1. Unpack the repeater.

Inventory the contents against the packing lists, and note any missing items.

3. Inspect for shipping damage, especially for damage that might have been hidden by
the packaging. Pay particular attention to the following:

*Bent or dented sheet metal

*Loose or broken components

*Damaged connectors

*Damaged or broken wiring or coaxial cables
*Missing or damaged contents of the accessory kit

*Missing or damaged optional equipment, ordered with the repeater unit.
If any items are missing or damaged, perform all of the following steps:

1. Report any missing or damaged items, by writing them on the shipping waybill.
Ask the delivery agent to sign the waybill, for verification of the loss or damage.
Notify the transfer (shipping) company as soon as possible.

Submit a damage report to the shipping carrier.

ISEN S

Send a written report of the loss or damage to the Field Services Department of
Repeater Technologies.

NOTE: Save the original shipping carton and packing materials, to reuse for any future
transport of the repeater unit. For example, a repeater might be moved to a new location
in a cellular/PCS network, or a damaged repeater might need to be returned to RTL
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RC1920C Repeater Reference Manual

1.1

Equipment Required, but Not supplied, for Installation

Table 1-1 lists required installation equipment RTI does not provide with a repeater. These
standard tools should be readily available from local suppliers of telephone, electronic, and/

or computer equipment.

NOTE: Installing an RTI repeater requires a site plan. These documents define the intended
parameters of the cellular/PCS network project, including the repeater’s coverage area, gain
settings, and antenna location. If necessary, consult a network administrator for more infor-

mation.

Table 1-1 Required Installation Equipment

Equipment

Function

Site Plan/Network Engineering documentation

Correctly configure the repeater to operate in the PCS/ Cel-
lular network.

1/8 inch Small Flat Blade Screwdriver

Use for AC input power and external alarm plugs.

3/16 inch Medium Flat Blade Bit Screwdriver

Use on the older entry box door and DC input power termi-
nals.

Y4 inch Hex driver

Detach security screws.

Voltmeter, Fluke 75 or equivalent VOM

Test voltage and power polarity.

Spectrum Analyzer

Test RF power output.

RF Signal Generator

Test antenna isolation.

Pilot scanner (optional)

Measure donor base station receiver power.

Type N (m) 50-ohm Termination, 10 W, (3 ea.)

Terminate antenna ports during off-air testing.

Mounting Hardware

Mount repeater, antennas and coax.

Electrical Wiring Equipment (as needed)

Connect external power to Repeaters.

Laptop Computer (Win95, 98, NT)

Configure, control and monitor the repeater through the

RepeaterNet craft port.
Pole Mounting Tightening/Crimping Tool (for | Mount the repeater to a pole and secure pole mounting
pole mounting only) straps.
Jumper Cables Type N (male to male) calibrate cables for Test Equipment

(length depends upon application).

Frequency Domain Reflectometer (Feed Line
Sweep Tester) Wiltron Site Master or equiv-
alent

Test Coax/Feed Line and Connector VSWR.

Directional coupler (2 each) -30 dB coupled
port

Test repeater power output.

1-2
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Unpacking and Inventory

Table 1-2 Accessory Kit Inventory

Part Number Description Quantity
129-0007-02 Wrench, Hex Key, 5/32” x 3-1/4” LG Short Arm 1
129-0008-01 Hex Bit, Pin-In Socket, 7/32” 1
519-1200-03 RepeaterNet Craft Software 1
187-0713-02 Cable Assembly, Comp (2M) 2X D-Sub 9-Pin, Male/Female 1
187-0929-01 Cable Assembly AC Power Cord 1
113-0015-01 Shipping Container (For OA1900C Only) 1
113-0016-01 Shipping Container (For OA850C Only) 1
550-5100-01 Repeater Reference Manual, Printed 1
550-5100-02 Repeater Reference Manual, CD-ROM (OA850C Only) 1
137-0446-01 Plug, Button, Recessed-Type Head (OA1900C Only) 1
137-0447-01 Fitting, Conduit, 1/2” LiquidTight 4
137-0447-02 Locknut, Standard Conduit 1/2” 1
129-0011-01 Hex Bit, 7/64” x 1” long Ball Point (1/4” Driver) For OA850C Only 1
519-5100-01 RTI Tools Disk (OA850C Only) 1
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Repeater Installation Check List

2.0

21

22

2.3

Introduction

This chapter includes a check list, which summarizes all of the steps required for success-
fully installing a repeater. Repeater Technologies, Inc. (RTI) recommends a thorough
review of the check list, both before and during installation of an RTI repeater.

Contacting Repeater Technologies

This section describes how to contact the Repeater Technologies corporate headquarters
at anytime before, during, or after installing a repeater, for sales information or technical
assistance for the RC1920C repeater, or for any of our communications or related prod-
ucts. Refer to the inside cover for contact information.

RepeaterNet Craft

Some of the steps in the installation process require using RepeaterNet Craft software.
This software is provided on the appropriately-labeled diskettes. Those diskettes are
included with this manual.

Checklist

The RC1920C Installation Checklist begins on the next page, and continues for a total of
four pages. The remaining chapters of this manual provide detailed descriptions of each
of the steps summarized in this checklist. The Installation Checklist is also included as a
single-sheet fold-out, in the front binder-flap of the printed Repeater Reference Manual. An
installer can take the fold-out sheet into the field, and consult it during the repeater
installation process. The checklist includes spaces for recording details about the repeater
site, and for checking off completion of each installations.

550-3100-01 Rev A 2-1



Repeater Installation Check List

RC1920C Repeater Reference Manual

RC1920C Installation Checklist

Site Name,

Location,

Serial Number

Bts Name/ sector

Bts Location,

1. Equipment Installation

1.1  Test Equipment Needed

1.2 Verify Bts Output Power

1.3 Install Antennas And Feed Lines

14  Run Sweep Test

1.5  Mount Primary F1 Repeater
Cabinet

1.6 Mount F2 Growth Cabinet

1.7 Mount Back-up Power System
(Bups)

1.8  Install Lightning Suppressors

1.9  Ground Equipment

1.10 Terminate Antenna Ports

111 Hook-up Electrical Power

2. Antenna Alignments
21  Align Donor Antenna

Sweep Tester, Signal Generator, Spectrum Analyzer, Pilot Scanner
(optional), and Voltmeter.

Verify that the donor BTS to the repeater site is running at rated output
power.

If a back-beam antenna is used, install a power divider.

Run a sweep test on all antennas and feed lines, upon completion of
their installation.

(Cabinet with Type-N RF connectors on bottom.) Remove the mounting
bracket from the cabinet, and mount the repeater on a pole, wall or uni-
strut. Hang the repeater over the outside of the mounting bracket, and
secure it. Leave room for the antenna feed connections, F2 Growth Cab-
inet, and BUPS, if applicable.

(Cabinet without Type-N connectors.) Mount to the left of (or above) the
Primary F1 Repeater Cabinet. Interconnect the two cabinets, using the
cables supplied. First connect the RF and alarm cables in one conduit,
and then the power cable in another conduit. Remove unused AC or DC
leads. (optional)

Mount to the right of the Primary F1 Repeater Cabinet. This supplies
DC power. (optional)

for all antenna feed lines and cabinets.

Connect repeater cabinet(s), BUPS, antenna feeds, lightning suppres-
sors, and any other equipment, to external ground.

Use Type-N 50-Ohm 20-Watt terminations. Two ports for non-diversity,
three ports for diversity.

Wire primary power to the dedicated 20-amp breaker. Open the entry
box on the bottom of the Primary F1 Repeater Cabinet. Verify proper
voltage & polarity (either +24 VDC or 117/230 VAC, not both). Connect
the repeater and/ or the BUPS to the power source. Connect the BUPS
alarm cable to ]2, if applicable. DO NOT TURN ON power.

Check RSL (Received Signal Level) from donor BTS. Connect Spectrum
Analyzer or Pilot Scanner (optional) to the antenna feed of Repeater
Donor antenna, and adjust the donor antenna position for maximum
RSL (set for 1 MHz RBW). Confirm polarization of the Donor antenna.
Measure at idle channel power.

Donor Antenna Polarity (V/h)

2-2
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Frequency 1
Frequency

Power

MHz
dBm

Desired Pn Scanner (If Using A Pn Scanner):

Ec/io

Power

dB
dBm

2nd Highest PN (if using PN Scanner):

Ec/io

Power

Frequency 2 (If applicable)

Frequency

Power

dB
dBm

MHz
dBm

Desired Pn (If Using A Pn Scanner):

Ec/io

Power

dB
dBm

2nd Highest Pn (If Using A Pn Scanner):

Ec/io
Power

22 Align Mobile Antenna(s)

23 Check Isolation

Isolation
Tx1 / RXmain
Tx2 / RXdiversity
3. Commissioning the Repeater

3.1 Turn On Power

3.2 Hook-up Internal Battery

dB
dBm

Using compass or topographic map mobile/subscriber antenna in
accordance with network engineering site plan.

Using a signal generator, inject up to 4 CW signals across the channel
(for Frequency 1) into the donor antenna feed (suggested power level is
0 dBm). Using a Spectrum Analyzer (set for 1 kHz RBW), measure the
received level on each subscriber antenna feed. Note the worst case dif-
ference in power levels. ISOLATION MUST BE GREATER THAN 80
dB, 110 dB is ideal. Repeat for Frequency 2, if applicable. Adjust the
antenna location, or introduce RF shielding, if more isolation is
required.

dB dB
dBdB (if applicable)

Open the entry box at the bottom of the Primary F1 Repeater Cabinet;

turn ON system power. THE RED “CRITICAL ALARM” LED ACTI-
VATES. THE REPEATER IS IN ALARMED STATE UNTIL POWER
AMPLIFIERS (PAs) ARE TURNED ON.

Connect the black lead to the negative terminal of the internal battery
backup —located in the entry-box.

550-3100-01 Rev A
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3.3  Update Software Load RepeaterNet Craft Software, provided in the accessory kit (four
floppy disks), onto an MS Windows 95/NT PC. (Even if RepeaterNet is
loaded on PC, a new Revision might be included with the repeater.)

3.4  Launch Repeaternet Craft Connect a PC to the Craft port (9-pin DB9 connector) in the Primary F1
Repeater entry box. Use the cable in the accessory kit. Launch the
RepeaterNet Craft program on the PC.

3.5  Update Firmware When adding F2 Growth Cabinet upgrades to existing (older) Primary
F1 Repeater Cabinets, update the firmware. See Step 5.16.

3.6 Update Configuration For 2 Using RepeaterNet Craft, select “Configuration/Hardware Settings” and

Channels click “Growth Box”. Click APPLY. Exit RepeaterNet Craft, and restart.

3.7  TURN PAs OFF Verify that Forward PA(s) and Reverse PA(s) are turned OFF. In Repeat-
erNet Craft, the FPA(s) and RPA(s) Icons should have a circle with a
slash over them. If not, select “Configuration/Channel 1/PA Control tab"
and turn OFF both FPA & RPA. Click APPLY. The FPA & RPA Icons
should now have a circle with a slash over it. Repeat for Channel 2, if
applicable.

3.8  Set Channel Numbers In RepeaterNet Craft, select “Configuration/Channel 1/Channel #". Enter
the Channel #. Click APPLY. Repeat for Channel 2, if applicable.

Frequency 1 MHz
Forward (Downlink) Channel #
Reverse (Uplink) Channel #
Frequency 2 (If Applicable) MHz
Forward (Downlink) Channel #
Reverse (Uplink) Channel #
3.9  Setgains to 65 Db Confirm that the repeater gain, under the “Configuration/Channel 1/Gain

tab” screen, is set to 65 dB for the forward (downlink) and reverse
(uplink) paths. Be sure to click APPLY. Repeat for Channel 2, if applica-
ble. Do not activate the PAs at this time.

3.10 Turn off power Exit RepeaterNet and remove the antenna terminations.

4. Repeater Alignment

*Requires two people: one at BTS, one at Repeater

41  Repeater Site Set-up

Connect the Donor antenna feed and Diversity TX; / RXpjyersity Mobile
feed (if applicable) to the Repeater. Connect the signal generator to the
Mobile TX; / RXpain port.

42  Bts Site Set-up Disconnect the antenna feed from the diversity antenna port. Connect a

spectrum analyzer to the diversity antenna feed (set for 10 kHz RBW).
43  Turn On Repeater
44  Turn On Reverse Pal

Login using RepeaterNet Craft.

Using RepeaterNet Craft, turn ON RPA1. Ensure that FPA1, FPA2 and
RPA2 are turned OFF. Click APPLY. See step 3.7.

45  Inject Test Signal Inject a -80 dBm signal at the Reverse (Uplink) frequency (Step 3.8).
Ensure that the input is -80 dBm, considering signal generator cable

losses. Activate signal generator (TRANSMIT).
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4.6

4.8

49

4.10
411

412

Set Reverse Gain For outdoor coverage - At the Repeater site, increase the Reverse gain of
Channel 1 in RepeaterNet Craft (see Step 3.9), until the spectrum ana-
lyzer at the BTS reads -82 dBm. Click APPLY.

If the BTS Donor Sector has a Tower-Top Low-Noise Amplifier
(TTLNA), the reading should be -75 dBm, if TTLNA Gain is 12 dB &
cable loss is 3 dB. (If gain is higher or loss is lower, add 1 dB for each 1
dB of improvement).

For indoor coverage, readings should be -92 dBm or -85 dBm, respec-
tively. Repeat for Channel 2, if applicable. DO NOT EXCEED THE ISO-

LATION IN STEP 2.3.
Gain Setting - Reverse (Uplink)
Channel 1 dB
Channel 2 dB (if applicable)
Disconnect Test Equipment At both sites, connect antenna feeds.
Set Forward Gain Set the Repeater Forward (Downlink) Gain setting so it is 2 dB higher

than the Reverse (Uplink) Gain setting. DO NOT EXCEED THE ISO-
LATION IN STEP 2.3. Click APPLY.

Gain Setting - Forward (Downlink)

Channel 1 dB
Channel 2 dB (if applicable)
Check For Oscillation In RepeaterNet Craft click the upper (Channel 1) “FPA icon/Channel 1 For-

ward PA Status/Measurement Tab”. Click Reset Low/High, and observe the
PA power levels. If the PA is consistently running “Over Range”, turn the
PA Gain down in 2 dB increments (see Step 3.9), until the PA is not regu-
larly “Over Range”. Repeat for Channel 1 (upper) RPA1 & Channel 2
(lower) FPA2 & RPA2, if applicable.

Back-up System Settings In RepeaterNet Craft, select “File/Upload Properties”, name a file. “Save”.

Exit RepeaterNet, close the repeater entry box, and seal the coax connec-
tions.

Set Switch Translations Modify the Cell Radius/ Access Acquisition Search Windows, and the

PAM_SZ, for new coverage. Modify SRCH_WIN_A, and
SRCH_WIN_N, for hand-offs.

5. Customizing the Repeater Installation

51

52

5.3

Launch Repeaternet Craft Connect the PC to the Craft port (9 pin DB9 connector) in Primary F1
Repeater Cabinet entry box. Use the cable provided in accessory kit.

Set-up Modem Must have modem option. Select "Configure/Modem/Modem Proper-
ties". Enter the Setup string, phone number to dial for NOC access, and
# of call attempts. Click APPLY. Select "Configure/Hardware Settings"
and Click "modem attached". Click OK. Exit RepeaterNet Craft, and
restart.

Set-up Pager Must have the modem option. Select "Configure/Modem/Pager Prop-
erties" and enter the pager number to dial, # of call attempts, and unique
numeric ID message to be sent to the pager. Click APPLY.
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5.4

5.5

5.6

5.7
5.8

59

5.10

511

512

513

5.14
5.15

5.16

Set-up Cellular Phone

Set-up Remote Or Direct Access

Password Protection

Set-up Color Independent Icons

Store Site Information

Connect External Alarms

Name External Alarms
Test External Outputs
Set-up Dc Voltage Alarm
Change Alarm Severity

View Alarm Log
Back-up System Settings

Update Firmware

Must have the modem option. Select "Configure/ Hardware Setting"
and Click "cellular phone attached". Click OK. In the Primary F1
Repeater Cabinet entry box, remove the cell phone and activate. Re-
install the cell phone in the entry box. Exit RepeaterNet Craft, and
restart.

Must have the modem option. Use to define whether access is a direct or
remote (via a modem) connection. Launch RepeaterNet Admin and
Click "Direct Connection" (or "Modem Connection" for remote access).
Click SAVE.

Select "Systems/Properties/System Login". Enter the Login ID and
Password. A zero indicates that the feature is not active. Click APPLY.

Select "Options/Independent Color Icons".

Select "System/Properties/System". Enter the System Name, Site Info,
and Site Phone Number. Click APPLY.

Wire ]2 for alarm info from the power source; J1 for 2 digital inputs &
outputs and DC Voltage Input; ]23 for 2 Form C Relay Contacts; J22 for
Repeater Critical, Major and Minor Alarm Form C Relays.

Select "Configuration/ Alarm Control Unit". Select the "I/ O Descrip-
tion" tab and fill-out the names. Click APPLY.

Select "Configuration/ Alarm Control Unit". Select the "I/O Controls"
tab and toggle ON/OFF/ON. Click APPLY after each toggle.

Select "Configuration/ Alarm Control Unit". Select the "Ext. DC Voltage"
tab and enter the min/max voltages. Click APPLY.

To change the factory default settings, select submenus of "Configure/
(item)" for each alarm severity change. Click APPLY for each change.

Select “System/ Alarm and Event Log”.

In RepeaterNet Craft, select “File/Upload Properties”, name a file.
"Save".

Insert "Firmware" floppy disk in drive (A). Select "File/ Update Repeater
Firmware/". Click "OK". “Save” current firmware on (C). Select firm-
ware file on Floppy (A). "Open". Follow the on-screen directions.

2-6
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Fiqure 2-1 Typical Installation
TBD
Fiqure 2-2 Checking Repeater Isolation
Top Jumper
Cables
Back-Beam Main-Beam
Antenna Antenna

Lightning Arrestors

H
/ Spectrum

L_H__I Analyzer
SG

Cable
- Signal

Feeder
Cables

Bottom Jumper
Cables

Generator
Donor Antenna I-T-l
Top Feeder Bottom SG
Jumper Cable Jumper Cable
Cable Cable
RT130102
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Figure 2-3

Mounting the Repeater

TBD
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3.0

Introduction

In a CDMA (IS95) network, the dynamic RF power output of a Base Transceiver Stations
(BTS) depends on the number of subscribers assigned to the BTS.

The IS-95 specification, for CDMA networks, describes four different channel types, all
contained within the forward channel:

* One pilot channel (measures power and performs initial synchronization).
* One sync channel (passes parameters during initial synchronization).

* 0 to 6 paging channels (passes parameters during operation).

* 0 to 62 traffic channels.

The total number of channels cannot exceed 64.

Usually, a portion of the base station’s total power is assigned to the pilot channel, the
paging channel, and the sync channel. The traffic channels use the remaining power. For
example, within an IS-95 network, the power allocations usually adhere to the following
convention:

Pilot Channel Power: 15 - 20%, depending on the requirements of the specific equipment manu-
facturer or service provider

Paging Channel Power: 6%
Sync Channel Power: 2%

The remaining 72-77% of the BTS power is available for communications traffic channels.

For each repeater installed into a CDMA network, you must determine the received
power level from the donor BTS, so that you can accurately set the repeater gain. If you
do not know the received power level, or if you use an inaccurate value, then the repeater
might become overdriven, and it might enter into an alarm condition.
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3.1

Measuring the Donor BTS Signal Strength

If the donor BTS is idle (not carrying any subscriber traffic), you can assume that the
repeater is radiating only pilot, paging, and sync power. If this is the case, connect a spec-
trum analyzer to the bottom jumper cable of the repeater’s donor antenna, and measure
the BTS power. Either use a spectrum analyzer that is equipped with a CDMA module, or
correct the measurement, for the resolution bandwidth of the spectrum analyzer.

For example, a CDMA Personality Module is available for Hewlett-Packard spectrum
analyzers, to measure CDMA power within a 1.25 MHz band. For spectrum analyzers
that do not have such a module, however, the closest measurement bandwidth is 1.0
MHz, so you must correct the measurement for bandwidth.

3.1.1 Measuring Donor BTS Idle Power

If the donor BTS is idle (no subscribers), then the only power that the BTS transmits is
pilot, paging, and sync. If this is the case, you can use either of two measurement meth-
ods:

* Spectrum analyzer.

¢ Pilot Scanner.

Both methods use the same equipment configuration, as shown in Figure 3-1.

Figure 3-1 Equipment Configuration for Measuring Donor BTS Power

| Subscriber Antennas | Donor
Antenna

Diversity Main

g ¥

REPEATER Donor
| _— antenna

He—T port

{T1
{T1

E z
Main Subscriber Port
Diversity
Spectrum SUbF?C:tlber
Analyzer (o]

T

RT130104

3-2
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Measurement Using a Spectrum Analyzer

Use the following procedure with a spectrum analyzer, to measure power from the Donor
BTS to the repeater.

1.

Connect the spectrum analyzer to the output end of the bottom jumper cable on the
repeater donor antenna, as shown in Figure 3-1.

Ensure that the donor BTS is idle (no subscribers), and that only the pilot, paging and
sync channels are active.

NOTE: If the spectrum analyzer does not have a CDMA measurement module, skip to
step 4.

3.

5.

If the spectrum analyzer has a CDMA measurement module or capability, configure
the analyzer to measure the CDMA signal. Then record the signal strength, and skip
to step 5.

If the spectrum analyzer does not have a CDMA measurement module, proceed as
follows:

a Configure the spectrum analyzer for a resolution bandwidth of 1.0 MHz, and for a
video resolution of 30 kHz.

b Set Video averaging to ON.
¢ Note and record the signal strength.

d To correct the reading for a 1.25 MHz bandwidth, add 0.9 dB to the reading. For
example, if the spectrum analyzer indicates -55 dBm, the corrected reading is -54.1
dBm (-54 dBm, for all practical purposes).

Move the antenna for maximum signal strength.

3.1.2 Measuring donor BTS Loaded Power

If the donor BTS is active (carrying subscriber traffic), you cannot use a spectrum ana-
lyzer to obtain an accurate measurement of the donor BTS signal strength. In this case,
you must use a Pilot Scanner and measure Pilot power directly.

Measurement Using a Pilot Scanner

1.

Configure equipment as shown in Figure 3-1, but substitute a pilot scanner for the
spectrum analyzer.

Configure the pilot scanner to measure ONLY the pilot channel of the donor BTS.

Move the antenna for maximum signal strength.
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Installing Antennas

4.0 Installing Water Protection for Antenna Connections

NOTE: This should be done after the repeater has been fully configured, functionally set-
up and not further work is required.

The bottom of an RTI RC1900C repeater cabinet includes N-type connections to donor
and subscriber antennas, as shown in Figure 4-1. RTI recommends that before installing
the repeater and connecting it to antennas, you apply a tar-like Vapor Wrap, to seal these
antenna connections against rain or other water sources.

1. Wrap the threads of the N-type antenna connectors, with electrical tape. This protects
the connector threads from the sticky Vapor Wrap substance.

2. Thoroughly coat the outside of the electrical tape, with the Vapor Wrap putty.

3. Wrap another layer of electrical tape over the Vapor Wrap, to seal the Vapor Wrap
into place.

After you complete this procedure for all N-type antenna connectors, water should not
adversely affect the connections between the repeater cabinet, and the donor and sub-
scriber antennas.
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Figure 4-1 N-Type Antenna Connectors, Looking Up From the Bottom of the Repeater Cabinet

TBD
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4.1 Antenna Configurations
RTI repeaters can use any one of four basic antenna configurations:

* Donor antenna, and one dual-polarized subscriber antenna (see Figure 4-2)
* Donor antenna, and two vertically-polarized subscriber antennas (see Figure 4-3)

* Donor antenna, and two dual-polarized subscriber antennas (one for main-beam and
one for back beam; see Figure 4-4)

* Donor antenna, and one vertically-polarized subscriber antenna (see Figure 4-5)

NOTE: When included in a CDMA network, an RTI repeater can use a back-beam
antenna, to transmit energy from the repeater, back towards the donor base station. A
back-beam antenna increases the allowable distance between the donor BTS and the
repeater site.
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Fiqure 4-2  Dual-Polarized Subscriber Antenna Configuration

+45” Port
-45” Port
Subscriber
Antenna
Y
18 - 20

Top Jumper Cable
(TX1/RX Main Receive)

Feeder Cable

(TX/Main Receive) Top Jumper Cable
(TX2/RX Diversity)
Feeder Cable
Aatoennor:'a —> ¢ (Diversity Receive)
Top Jumper
Cable (Donor)
Feeder Cable
(Donor)™ >
To Lightning Arrestor Assembly RT295904
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Fiqure 4-3 ~ Two Vertically-Polarized Subscriber Antennas

Vertically
Polarized
Antennas
TX/RX RX Diversity
Main Antenna Antenna
T
18 - 20
Top Jumper Cable
(TX/Main Receive)
; v
Feeder Cable Top Jumper Cable
(TX1/RX Main Receive) (TX2/RX Diversity)
An[?gr?r?er\ —_ Feeder Cable
< (Diversity Receive)
Top Jumper
Cable (Donor)
Feeder Cable ;
(Donor)
To Lightning Arrestor Assembly RT295901
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Figure 4-4

Back-Beam
Antenna

Top Jumper Cable /

(Back-Beam Diversity Receive)

Top Jumper Cable
(Back Beam TX Main Receive)

Direct Port

Coupled Port ——»

Power Divider ———»

Feeder Cable

(TX1/RX Main Recelve)\
Donor
Antenna >

Top Jumper
Cable (Donor)

—

Feeder Cable
(Donon™*>

Back-Beam Antenna Configuration

|<— ca. 4ft. —>|

+45” Port +45” Port
-45” Port -45” Port
Main-Beam
Antenna '
L
A\

18 - 20

\ Top Jumper Cable
(Main-Beam TX

/Main Receive)

Top Jumper Cable

le«—— (Main Beam
Diversity Receive)

«—— Direct Port

Coupled Port

AR

Power Divider
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Fiqure 4-5  Non-Diversity Antenna Configuration
TBD
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4.2

4.3

Antenna RF Cables

A repeater uses the same type of RF cabling as a base station does. Usually, the top and
bottom jumper cables are made from flexible, 1/2" air dielectric coaxial cable, and the
feeder lines are made from 7/8" to 1-5/8" foam dielectric coaxial cable.

Diversity repeater configurations (see Figure 4-2, Figure 4-3, and Figure 4-4) require
three(3) RF lines:

¢ One for the donor antenna
¢ One for the main subscriber antenna

* One for the diversity subscriber antenna, if applicable
Lightning Protection

RTI strongly recommends installing lightning arrestors on all feeder cables to the
repeater. A direct lightning strike can damage any electronic equipment. Damage result-
ing from a lightning strike is not covered under the RTI manufacturer's warranty,
whether or not you use lightning arrestors. However, using lightning arrestors can mini-
mize the risk of damaging a repeater, and of losing cellular phone coverage, during light-
ning storms.

Use lightning arrestors that attach directly to the large-diameter feeder cables, and not to
the repeater itself. Do not use screw-on lightning arrestors, because they attach to the
repeater's antenna terminals. Shunt the lightning to the ground, as far away from the
repeater as possible.

RTI further recommends installing CSX (800 MHz) or PCX (1900 MHz) PolyPhaser (or
equivalent), micro lightning protection, which attaches directly to the type-N connectors
of the repeater (see Figure 4-6). After the PolyPhaser is attached, water-proof both the
arrestor and connector with Vapor Wrap and electrical tape as described in Section 4.0,
“Installing Water Protection for Antenna Connections” on page 4-1.
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Fiqure 4-6 ~ PSX PolyPhaser, for Lightning Protection

RT130106
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Figure 4-7 shows a typical repeater installation, using coaxial lightning arrestors on the
feeder lines. For safety and operational dependability, RTI also recommends attaching all
antennas to the repeater site's single point ground.

Fiqure 4-7  Lightning Arrestor, Grounding, and Repeater RF Cabling

TBD
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4.4

4.5

Back-Beam Antennas and Directional Couplers

A back-beam antenna transmits a portion of the repeater's power back toward the donor
base station (BTS). This technique is helpful on long rural routes, where two repeaters are
cascaded. In suburban or rural areas, this type of antenna can provide additional signal
capability, in the area between the donor BTS and the repeater site.

As shown in Figure 4-4, power from the repeater is applied to a directional coupler (or
power divider), which divides the power proportionately to both the main-beam and
back-beam antennas. These couplers are available in several power division ratios:

* 50/50
60/40
75/25
80/20
90/10

These ratios represent the percentage of total power that the repeater channels either to
the direct port (the higher number) or the coupled port (the lower number). For example,
if the repeater uses a 75/25 coupler, the repeater sends 75% of its power to the main-beam
subscriber antenna, and the remaining 25% to the back-beam antenna.

Measuring Antenna Isolation

Measure the actual isolation between the antennas, to ensure that the donor (base station)
antenna is sufficiently isolated from the subscriber (mobile) antenna.

WARNING: This is a crucial step in all repeater installations.

If the isolation is not sufficient, the repeater might oscillate, or it might operate with less
gain (signal amplification). In the first case, the repeater can introduce spurious emissions
into the network. The second case, reduces the range of the repeater's coverage area.
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Fiqure 4-8  Equipment Setup for Measuring Antenna Isolation
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Measuring antenna isolation requires a signal generator and a spectrum analyzer. The
generator transmits a signal from the donor antenna, and the spectrum analyzer mea-
sures the same signal as the subscriber antenna receives it. Figure 4-8 shows the equip-
ment set-up for each antenna configuration.

Figure 4-8 shows four simplified setups. They show only the overall configuration for
measuring antenna isolation. Isolation must take into account all cables that will be
attached when the repeater is in operation. So you must measure isolation with all jump-
ers and feeder lines in place. The only other cables present, that are not part of the actual
isolation measurement, should be the one from the signal generator, and the one to the
spectrum analyzer. Figure 4-9 shows all cables and equipment in place for measuring
actual antenna isolation.

Figure 4-9  Antenna Isolation Measurement - Equipment Configuration

Top Jumper
Cables

Main-Beam
Antenna

H Lightning Arrestors
/ Spectrum

L_H__I Analyzer
SGsa

Back-Beam
Antenna

Feeder
Cables

Bottom Jumper

Cables
/
\ T
- Signal
Generator
Donor Antenna I-T-l
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Jumper Cable Jumper
Cable Cable RT130109

NOTE: If the repeater uses a back-beam antenna, you must measure antenna isolation
from both ports of both antennas (four measurements). If the repeater uses only one
antenna, only two isolation measurements are needed: one from the left port, and one
from the right port, of the subscriber antenna.

In all cases, measure antenna isolation with all cables, connectors, and lightning arrestors
in place. Record all measurements for future reference.
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The equation for antenna isolation is

ISO =Pgen - Le.gen + Lesa - Psa

Where:
ISO = Isolation in dB between the antennas
PGEN = Output level of the signal generator (dBm)
LC-GEN = Loss of the signal generator cable (dB)
PSA = Power indicated on the spectrum analyzer (dBm)

This equation holds true for one donor antenna, and for one vertically-polarized subscriber antenna. For a
dual-polarized antenna, the equation becomes:

ISO = PGEN - LC-GEN + LC-SA - MAX(PSA(L), PSA(R))
Where:

PSA(L) = Spectrum analyzer level measured on the left antenna port.

PSA(R) = Spectrum analyzer level measured on the right antenna port.

The stronger of the two readings represents the actual isolation available. For example:

PGEN = 0 dBm

LC-GEN = 1.0dB

C-SA = 1.0dB

PSA(L) = -90 dBm

PSA(R) = -88 dBm

ISO = 0- MAX(-90 or -88) = 98 dB

NOTE: A signal level of -88 dBm is stronger than a level of -90 dBm.

In this example, the usable antenna isolation is 98 dB.

To help you calculate the minimum required antenna isolation, RTI provides a simple
tool called Isolation Calculator, which is Tab 4 in the RTI Tools Design 97 Workbook.
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4.6 Sweeping the Antenna Cables

RTI recommends sweeping all RF cables for the repeater, using a network analyzer or a
time-domain reflectometer. This procedure is similar to the sweeping required for a nor-
mal base station. At a minimum, record the following data, for each cable or cable assem-
bly:
* Return Loss (dB): the ratio of power transmitted to, versus reflected from, the cable.
* Voltage Standing Wave Ratio (VSWR): a factor in measuring the cable's impedance.

* Insertion Loss (dB): the ratio of power delivered with the cable, versus without the
cable.

* Distance (in feet or meters) from one end of the cable, to a detected fault.

CAUTION: Caution: If the sweep finds any faults, correct them before placing the
repeater into service.
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Mounting the Repeater

5.0 Installation Overview

RTT repeaters are designed for indoor or outdoor installation, and can be mounted onto
either a wall or a pole. The unit's compact cabinet simplifies installation, and its aestheti-
cally-acceptable design means that it conforms to zoning standards in many locations.

RepeaterNet Craft software is required, throughout the physical installation of the
repeater. Before installing the repeater, do the following:

1. Pre-load the Craft software onto the laptop computer that you will use at the installa-
tion site.

See RepeaterNet Craft for the OA850C NR, for information about installing and
using RepeaterNet software.

2. Retrieve the DB-9 cable from the Repeater Accessory Kit. Use this cable to connect
the laptop with the repeater.

NOTE: Only qualified service or technical personnel should install the repeater.

Figure 5-1 shows a typical repeater installation, with installed components.
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Fiqure 5-1 Typical Repeater Installation

TBD

5.1 Planning and Mounting Associated Equipment and Planning

Mount the donor and subscriber antennas, the antenna coaxial cabling, and the optional
Back-Up Power Supply (BUPS), before mounting and wiring the repeater.

If the repeater site requires two channels, install both a main (primary channel or F1)
repeater, and a growth cabinet or F2 (to house the second channel). Be sure to allow
enough space, either above or to the left of the main repeater, for mounting the growth
cabinet. See Figure 5-12, Figure 5-13, and Figure 5-14.
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Mounting the Repeater

5.2 Mounting the Repeater

Figure 5-2 shows a side view of the repeater, with the rear mounting bracket attached, as
shipped from RTI. Use this detachable mounting bracket when installing a repeater on
either a wall or a pole.

Figure 5-2

Rear Mounting Bracket with Unit - Side View

TBD
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Figure 5-3 illustrates the bracket for mounting the repeater, and shows its dimensions. In
both the wall-mounting and pole-mounting installation instructions that follow, this
bracket is detached from the repeater, attached to the wall or pole, and then reattached to

the repeater.

Figure 5-3

Rear Mounting Bracket

TBD

5-4
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5.2.1 Wall Mounting

Hardware for wall-mounting a repeater includes the following;:

* Four(4) lag (hexagonal-head) bolts
* Four(4) flat washers

* Four(4) lock (split) washers (optional)
To mount the repeater on a wall:

1. To separate the rear mounting bracket from the repeater, remove the security bolts
and washers.

To do this, use either a ratchet or a 1/4" hex driver, and the 7/32" pin-in-socket driver that
is provided in the accessory kit (see Figure 5-2).

2. Using the mounting hardware (hex-head lag bolts, lock washers, and flat washers),
secure the bracket to a wall, as shown in Figure 5-4.

Figure5-4  Installing Rear Mounting Bracket on a Wall

TBD

3. To set the repeater into the bracket, align the top of the repeater cabinet just above the
top of the mounting bracket, so that the mounting bracket will fit inside the left and
right walls of the repeater cabinet.

4. Slide the repeater cabinet downward, so that the guide bolt (on the repeater cabinet)
slips into the guide slot (on the mounting bracket), as shown in Figure 5-5.
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Fiqure 5-5  Guide Bolt and Slot

TBD

5. Replace the attachment bolts and washers, removed in Step 1. See Figure 5-6.
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Figure 5-6 ~ Repeater Mounting and Hardware Placement

TBD
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5.2.2 Pole Mounting
RTTI offers optional pole-mounting equipment, which you can order with the repeater.
Pole installation requires the following materials:

* Pole mounting kit (available from Repeater Technologies). See Table 5-1.

* Banding kit (purchased separately; available from McMaster-Carr), for mounting the
repeater on a concrete or metal pole. See Table 5-1.

* Class A - Pole Line Hardware, for bolting the Pole Mounting Bracket to a wood pole.

Class A - Pole Line Hardware is a telephone term. It specifies bolts and screws that
have a heavy electro-galvanized plating, so they do not rust. This type of rugged
hardware typically is available from telephone equipment distributors, such as Gray-
bar Electric, ALLTEL Supply, Spring-North Supply, PowerTel Supply, and so on. The
same type of hardware is also available from antenna suppliers, and from tower erec-
tor companies.

The Pole Mounting Channel is designed so that the repeater is squarely mounted on the
pole, and does not wobble.

When mounting the repeater onto a concrete or metal pole, use the Banding Kit. You usu-
ally would not drill a mounting hole through the center of a concrete pole. Similarly,
because metal poles might have cables running up the center, drilling is not recom-
mended. In both cases, banding is preferred over drilling.

However, wood telephone-type poles are easier to drill, so you can use lag screws or
through-pole bolts to fasten the pole-mounting channel.

Table 5-1 describes the Pole Mounting and Banding Kits. Because the Banding Kits
includes 100 feet of band, you do not need to purchase a separate kit with every repeater.

NOTE: The process of pole-mounting a repeater requires two people.
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Mounting the Repeater

Table 5-1 Pole Mounting and Banding Kits
Quantity Item
Pole Mounting Kit (091-0215-01)
1 Pole Mounting Channel
4 Bolts
4 Lock (Split) Washers
4 Flat Washers
4 Tapered Plug, .312D Hole
3/4-inch Banding Kit (Part No. 5653K12)
(McMaster-Carr Supply Co., Los Angeles, CA, USA, Tel. # (562) 692-5911)
1 Tightening-Crimping Tool
100 ft. 3/4-inch, Type 201 Stainless Steel Band
100 Stainless Steel Buckles
25 Stainless Steel Scru-Lockt Buckles
1 Carrying Case

To mount the repeater to a pole:

1. To separate the rear mounting bracket from the repeater, remove the security bolts
and washers.

To do this, use either a ratchet or a 1/4" hex driver, and the 7/32" pin-in-socket driver
that is provided in the accessory kit (see Figure 5-2).

2. Using the hardware provided with the accessory kit, secure the rear mounting
bracket to the two(2) pole brackets - see Figure 5-7.
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Fiqure 5-7  Pole Mounting Hardware
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3. Insert the four plugs provided, into the four outer holes in the rear mounting bracket.

4. Position the rear mounting bracket (the bracket that has an attached pole channel)
against the pole, and hold it in place.

5. While one person holds the rear mounting bracket in place, the second person
installs the steel bands that hold the bracket against the pole.

Consult the manufacturer's instructions (included with the Banding Kit) for this proce-
dure.

6. To set the repeater into the bracket, slide the guide bolt into the guide slot.

7. Secure the repeater to the bracket, using the security screws and washers, removed in
Step 1.
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Fiqure 5-8  Pole Mount - Side View
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5.2.3 Grounding the Repeater

A Repeater Technologies application note, titled Installation Standards for Grounding
Requirements (Document Number 650-0002-01, Rev. 2), provides detailed grounding
information for RTI repeaters. Contact Repeater Technologies to receive a copy of this
application note.

Installing the input power to the repeater includes installing the standard electrical ser-
vice grounds. However, you must also make sure that the RC1920C Cabinet/Chassis is
properly grounded to a water pipe or earth ground.

Each repeater cabinet (F1/Primary and F2/Growth) includes two external grounding
lugs: one on the repeater cabinet, and one on the Entry Box under the cabinet, as shown
in Figure 5-9.
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Fiqure 5-9  Location of Ground Lug on Primary Cabinet

TBD

1. Connect number 6 (or larger) gauge AWG solid wire, to each ground lug.

2. Carefully dress the wire along cabinet, and the mounting surface, to the Repeater
Grounding System or the Ground Rod.

NOTE: When dressing the grounding wire, and forming it around corners, avoid mak-
ing sharp bends in the wire. Use a generous radius for each wire bend.

Connect the screw-compression ground lug (located on the left exterior of the repeater's

Entry Box) to a suitable earth ground - for example, to a copper ground rod, copper pipe,
grounded steel building frame, or similar ground point. Use 2 to 7 mm, No. 6 to 2 AWG,
copper wire - see Figure 5-10.

CAUTION: Ground all other cabinets, enclosures, antennas, and coaxial cables used for
installation, to reduce any damage from a lightning strike or power surge.

5-12
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Fiqure 5-10  Typical System Ground
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Fiqure 5-11  Wiring and Ground Connections, At Left Interior of Repeater Entry Box

TBD
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Fiqure 5-12  Vertically-Mounted Growth Cabinet Example

TBD

Figure 5-13  Horizontally-Mounted Growth Cabinet Example

TBD
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Fiqure 5-14  Growth Cabinet Example with BUPS-25/80

TBD
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Functional Repeater Test

6.0

6.1

6.2

Overview

This chapter describes how to test a repeater from Repeater Technologies, Inc. (RTI), to
verify that it is operating properly. You must perform these tests, before connecting the
repeater to an antenna system.

Test Equipment Required

Table 6-1 lists test equipment and tools required for testing RTI repeaters. You can substi-
tute equivalent equipment.

Table 6-1 Required Equipment for Testing Repeaters

Item For Testing

Voltmeter, Fluke 75 Electrical Power

Type N (m) 50 ohm termination, 20 W (2 ea.) | Off Air

Laptop computer RepeaterNet Configurations
Screwdriver, 1/4-inch, 6 mm blade Wiring
Screwdriver, #1 Phillips Wiring

Applying Power to the Repeater

NOTE: When RTI ships the repeater from the factory, the Forward and Reverse Power
Amplifiers (PAs) are left in the Off position, and the secondary battery inside the
repeater's Entry Panel is disconnected.

1. Remove the antenna cables, and terminate the repeater's antenna ports, using Type-
N (male) 50 ohm terminations.

2. Apply primary power, AC or DC, as required.

Refer to Chapter 8, Connecting the Power Source, for detailed instructions.
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6.3

NOTE: The Critical and Minor LEDs, located on the Repeater Entry Panel, should be On
(illuminated).

3. Measure the AC/DC voltage at the Input Power connector in the Entry Panel.
Make sure that the voltage is within the operating parameters of the repeater:

* 110/230 Volts AC or +24 Volts DC

Checking Repeater Properties

NOTE: When the Repeater is shipped from the factory, the Subsystem Properties alarms
are configured to the Default setting.

1. Connect the laptop computer to the Craft port, O1.
2. Start RepeaterNet.
3. Use the RepeaterNet Craft Admin program to connect the Repeater.

NOTE: You must perform this step before you can access the RepeaterNet Craft soft-
ware.
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Figure 6-1 RepeaterNet Craft Software Start-up Screen

i Untitled - Repeateriet

File Help
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Connecting to Repeater...

RT130131

4. Use the subsystem Properties screen to check the repeater.

To open a Properties screen, select a subsystem from the Configuration menu selections
listed below:

* Front End

* Channel 1

e Channel 2

* Alarm Control Unit (ACU)
* Modem

¢ Cellular Phone

* Power System

* UPS

* Hardware Setting
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6.3.1 Checking the Power System Properties

1. Select Power System from the Configuration menu, in the Main Control screen.

The Power System Properties screen opens, and lets you view or redefine the settings of
the power system.

2. Select the Alarm Setting tab.

Table 6-2 shows the types of power system alarms, and their default severity settings.

Figure 6-2  Power System Properties Screen

Power System Properties

Alarmz Setting l

&larm Descriphion ] Severity |
Primary Input Power Alarm Properties Dizabled
Battery Alarm Properties Dizabled

Primary Power Supply Surmmary Alarm Properties Dizabled
Growth Power Supply Summary &larm Properties Dizabled
Growth Input Power Alarm Properties Dizabled

4 4 4 4 4

0K | Cancel Help

RT130132

Table 6-2 Power System Alarm Types and Default Settings

Alarm Default Severity Setting
Input Power Alarm Critical
Power Supply Alarm Critical
PS Battery Alarm Minor
Growth Box Input Power Alarm Major
Growth Box Power Supply Alarm | Major

6.3.2 Checking the Front End Subsystem

1. Select Front End from the Configuration menu, in the Main Control screen.
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The Front End Properties screen opens, and lets you view or redefine the settings of the
front-end system. The Front End subsystem consists of the Forward Front End, Reverse
Front End, and Diversity Front End.

Fiqure 6-3  Forward Front End Status Screen

Forward Front End Status
Alarm ]
Description | Status | Date J Time
FwdFE Summmary dlarm Dizabled 20000112 1748:33

Ok, | Cancel

RT130133

2. Select the Alarm Setting tab.

Table 6-3 shows the types of front-end alarms, and their default severity settings.

Table 6-3 Front End Alarm Types, and Default Settings

Alarm Default Severity Setting

Forward Front End Alarm Critical

Reverse Front End Alarm Critical

Diversity Front End Alarm | Critical
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6.3.3 Checking Channel 1 or Channel 2

1. Select Channel 1 (for standard repeaters) or Channel 2 (for Growth-Box units only)
from the Configuration menu, in the Main Control screen.

The Channel Properties screen opens, and lets you view or redefine one of the Channel
Properties.

2. Select one of the following Channel Properties tabs:

Reverse PA

Forward PA

PA Control

Channel Reverse Filter

Channel Forward Filter
Channel #

Channel Gain

Figure 6-4  Channel Properties Screen, Reverse PA Tab

Channel 1 Properties

Fiev. P& | Fuud P& | PA Control | Rev. Fiter | Fd. Fiter | Charriel #] Gain |

Alarmn Descrption I Severty |
FRevPal Summany Alarm Froperties Minor -
RevPAl Ext. Shutdown Alarm Properties b ajor -
RevPAl ALC Alarm Properties Dizabled -

k] | Cancel Apply Help

RT130134
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Reverse PA Tab

Table 6-4 shows the types of Reverse Power Amplifiers alarms, and their default severity

settings.

Table 6-4 Reverse Power Amplifier Alarm Types, and Default Settings

Alarm Default Severity Setting
Reverse PA Alarm Critical
Reverse PA1 Thermal Major

Reverse PA Ext. Shutdown Alarm | Disabled

Forward PA Tab

Table 6-5 shows the types of Forward Power Amplifier alarms, and their default severity

settings.

Figure 6-5  Channel Properties Screen, Forward PA Tab

Channel 1 Properties
Fiew. P4 Fwd PA | Pa Control | Flev. Fiter | Fiud Fiter | Channel # | Gain |
Alarm Description J Severity |
FwdPAT Surmmary &larm Properties Dizabled -
FindP&] Ext. Shutdown Alarm Properties [izabled -
FwdPa] ALC Alarm Properties [iizabled -
Ok, | Cancel Apply Help

RT130135
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Table 6-5 Forward Power Amplifier Alarm Types, and Default Settings

Alarm Default Severity Setting
Forward PA Alarm Critical
Forward PA1 Thermal Major
Forward PA Ext. Shutdown Alarm | Disabled

PA Control Tab

The Channel Control tab provides a switch to turn PA (Power Amplifier) power either
On or Off.

1. Set both the Forward PA and Reverse PA to On.

2. Check that the Channel 1 Forward and Channel 1 Reverse Power Amplifier icons, on
the Main Control screen, both turned Green.

Figure 6-6 Channel Properties Screen, Channel PA Tab

Channel 1 Properties

i"| Rev. Fiter | Fwd. Fiter | Chanrel # ] Gain |

Reverze P& Power Forward Péy Power

ak | Cancel

RT130136
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Channel Reverse Filter Tab

Table 6-6 shows the types of Channel Reverse Filter alarms, and their default severity set-

tings.

Table 6-6 Channel Reverse Filter Alarm Types, and Default Settings

Alarm Default Severity Setting

CSF 1 Rev Alarm | Event

6-9
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Channel Forward Filter Tab
Table 6-7 shows the types of Channel Forward Filter alarms, and their default severity

settings.

Figure 6-7 Channel Properties Screen, Channel Forward Filter Tab

Table 6-7 Channel Forward Filter Alarm Types, and Default Settings

Alarm

Default Severity Setting

CSF 1 Fwd Alarm

Event

Channel 1 Properties
Rev. P4 | Fwd. P4 | P& Control | Rev. Fiter | Channel # ] Gain |
Slam Descrption ] Severty |
FwdCSF1 Summary Slarm Properties Dizabled -
FwdC5F1 Lock Alarm Froperties Dizabled -
0K | Help
RT130137
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Channel # Tab

The Channel # tab lets you check the operating channel for either Channel 1 or 2. After
you select a channel, the RepeaterNet Craft software displays the corresponding frequen-

cies.

Figure 6-8 Channel Properties Screen, Channel # Tab

Channel 1 Properties

Rev. P4 | Fwd. P4 | PA Control | Rev. Fiter | Fwd Fiter Channel # | Gain |

Chatinel Mumber 356
Famward Frequency [(MHz) 38068
Reverse Frequency [MHz] 83568

Ok | Cancel

RT130138
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Channel Gain Tab

The Channel Gain tab lets you change the Forward and Reverse gain of the currently-
selected channel. Use the following procedure to adjust Forward PA or Reverse PA Gain.

1. Click the Gain tab.

Press and hold the mouse button, and drag the horizontal sliders to the defined for-
ward and reverse gain.

3. Click Apply (to set the channel gain and leave the form open) or OK (to set the chan-
nel gain and close the form).

The Gain value box (centered under each slider) displays the selected value.

Figure 6-9 Channel Properties Screen, Channel Gain Tab

Channel 1 Properties
Rew. P4 | Fwd P4 | P4 Control | Rev. Fiter | Fud Fiter | Channel # Gain |
Fonmard
£5 &b % &
95
Bewerse
E5 dE 95 dB
a5

Ok | Cancel

RT130139
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6.3.4 Checking the Alarm Control Unit (ACU)

1. From the Configuration menu in the Main Control screen, select ACU.
The ACU Properties screen opens. This screen includes the following tabs:

* I/O Descriptions

* 1/0O Control

* Alarms

* DC Voltage Alarm Threshold

2. Use the I/O Description and I/O Control tabs, to check external equipment that is
connected to the RTI repeater.

Fiqure 6-10  ACU Properties Screen, Alarms Tab

Alarm Control Unit Properties

140 Descriptions] 1/0 Controls  Alarms ] Ext DC antage]

Alarmn Descnption I Sewverity |
Ent. Input 1 Alarm Properties Miror -
Eut. Input 2 Alarm Properties Minor -
Ext. DC Yoltage Alarm Froperties Dizabled -
Primary Tamper Alarm Froperties Mimar -
Ext. Tamper Alarmi Properties Mirar -
Growith Tamper Alarm Froperties Mirar -

0K | Cancel Apply

RT130140
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ACU Alarm Tab

Table 6-8 shows the types of Alarm Control Unit alarms, and their default severity set-

tings.

Table 6-8 Alarm Control Unit Alarm Types, and Default Settings

Alarm Default Severity Setting
Ext. Input 1 Alarm Disabled
Ext. Input 2 Alarm Disabled
Temp Alarm Minor
Tamper Alarm Major
Analog Input Alarm Disabled
External Growth Box Alarm Major

NOTE: If the repeater does not have a Growth Box attached, all Growth Box alarms are

disabled.

Open the Repeater Main door, to cause a Tamper alarm. The ACU icon changes from

Green to Yellow.

6-14
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6.3.5 Checking Modem Properties
1. From the Main Control screen, select the Configuration menu.

2. From the Configuration menu, select Modem.
The Modem Properties screen opens. This screen includes the following tabs:

* Alarm Setting
* Modem Properties

* Pager Setting
Alarm Setting Tab

Table 6-9 shows the types of Modem alarms, and their default severity settings.

Fiqure 6-11  Modem Properties Screen, Alarms Tab

Modem Properties

Alarms Setting ] todem F'loperties] Pager Setting]

Alarmn Description | Severity |
Modem Summary larm Properties inar -

ITI Cancel Apply

RT130141

Table 6-9 Modem Alarm Types, and Default Settings

Alarm Default Severity Setting

Modem Alarm Minor

NOTE: If the repeater does not have a modem, the Modem Properties alarm is disabled.

550-3100-01 Rev A
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Modem Properties Tab

The Modem Properties tab lets you check the values for the Setup, Phone Number, and
Call Attempts. You can use these values only if you are using RepeaterNet Network

Management System (NMS).
Figure 6-12  Modem Properties Screen, Modem Properties Tab

Modem Properties

Alarmsz Seting  Modem Properties ] Pager Setling]

Setup Sking: |53?’=5

Fhaone Murnber: |I-4DB-555-SDB?

Call Attempts: 3
Baud Rate: 192K -

Farity: Mohe -
[1ata Bits Dial Type
7 * Tone
= g " Pulse

Ok | Cancel

RT130142
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Pager Setting Tab

The Pager Setting tab lets you check the value for the Pager Number, Call Attempts,
Repeater Number, and Minimum Alarm Severity.

Figure 6-13 ~ Modem Properties Screen, Page Setting Tab

Modem Properties

Alarms Setting] Modem Properties  Pager Sefting ]

Fager Mumber: |

Call Attempts:
Bepeater Murmber:
birirnum Alarm Severity: m

ak. | Cancel

RT130143
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6.3.6 Checking Cell Phone Properties

1. From the Main Control screen, select the Configuration menu.

2. From the Configuration menu, select Cell Phone.

The Cell Phone Properties screen opens. Table 6-10 shows the types of Cell Phone alarms,
and their default severity settings.

Figure 6-14  Cellular Phone Properties Screen

Modem FProperties

Alarms Setting ] b odem F'roperlies] Pager Selling]

Alarmn Description | Sewverity |
Cell Phane Summary Alarm Properties Mirar A

lTl Cancel Apply

RT130144

Table 6-10  Cell Phone Alarm Types, and Default Settings

Alarm Default Severity Setting

Modem Alarm Minor

NOTE: If the repeater does not have a cellular phone, the Cell Phone Properties alarm is
disabled.
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6.3.7 Checking Back-Up Power System (UPS) Properties

1. From the Main Control screen, select the Configuration menu.

2. From the Configuration menu, select UPS.
The UPS Properties screen opens.

Table 6-11 lists the Back-Up Power System alarm types, and their default severity set-
tings.

Table 6-11  Back-Up Power System Alarm Types, and Default Settings

Alarm Default Severity Setting

AC Fail Alarm Disabled

Low Battery Alarm Disabled
High Battery Alarm Disabled
Charger Fail Alarm Disabled
UPS Summary Alarm | Disabled
UPS Tamper Alarm Disabled
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6.4

Preparing the Repeater for Operation

After you successfully complete all of the foregoing steps, the repeater is ready to place
into service. Proceed as follows:

1. Enter the PA control screen, and turn off the forward and reverse Power Amplifiers
(see Figure 7-16).

2. Remove the terminations from the repeater's antenna ports.
3. Reconnect the antenna cables.
Proceed to chapter 7, Connecting External Alarms, for information about connecting

external alarms. Then see chapter 8, Connecting the Power Source, for the final connec-
tion of primary power (final configuration of the repeater).

NOTE: The output power of the repeater can approach 7 to 8 Watts (39 dBm), under
some circumstances. The directional couplers used must have at least 30 dB coupled
ports, to allow direct connection to a spectrum analyzer.

Figure 6-15  PA Control Screen

Channel 1 Properties

Rew. P4 | Fud. Pa {1 1| Riew. Fiter | Fwd. Fiter | Channel # | Gain |

Reverse PA Power Fanward Pa, Power

ak. | Cahicel

RT130136
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7.0 Overview

This chapter describes how to connect external equipment that sends a visual or audible
signal, whenever an alarm condition occurs at a repeater site.

7.1 Alarm and Control Wiring

Figure 7-1 shows the external alarm inputs and outputs connectors for an RTI repeater.

* Use Connector ]2 to wire alarms from the Back-Up Power Supply (BUPS) to the
repeater.

* Use Connector J1 for digital inputs to custom external alarms, or for digital outputs
to remotely-controlled devices at the repeater site. You can also use this connector for
external shutdown of the forward and reverse power amplifiers, if required.

* Connector ]23 provides two independently-controlled dry contact relays, each with
standard 1C contact sets. RepeaterNet software can use these relays to control
devices at the repeater site.

* Connector ]22 provides three independent relays, with contact sets in standard 1C
form. Each relay is driven by specific summary alarms that the repeater generates.

For example, one relay activates whenever the repeater generates any critical alarm.
Similarly, the second relay activates whenever the repeater generates any major
alarm, and the third activates on any minor alarm.

You can use these relay contacts to activate external alarms or other equipment, in
the event of a repeater alarm.

Figure 7-1 shows the location of these connectors on the repeater. The plugs are actually
removable terminal blocks. To connect to these terminals, use the following procedure.

1. Remove the appropriate terminal block.

Figure 7-1 shows connector (terminal block) J1 removed.
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Fiqure 7-1  Input/Output Terminals

TBD

2. Insert wires into the appropriate input and output pins.
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3. Secure each wire to its pin, using the screws provided, as shown in Figure 7-2.

Figure 72 Wire Connected to Terminal 1

RT130147

4. Repeat Steps 2 and 3 to connect wires to all input and output pins.

5. Reinsert (plug in) the terminal blocks to the appropriate slot on the repeater.

The plugs are polarized; you cannot insert them incorrectly.

CAUTION: Do not exceed the specified voltage and current limits of the alarm outputs
and inputs. Excessive voltage or current can damage the repeater.

External Alarm Pins

Table 7-1 lists all of the input and output connections, pin numbers, and functions, for all
repeater's external alarm connectors.

NOTE: The ground reference for J1 and J2 inputs and/ or outputs is the chassis ground
terminal.
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Table 7-1 Input/Output Pin Descriptions
Block | Pin # Signal Name Function
J1 1 Digital Output 1 User Controllable Open Collector Driver
In/Out | Digital Output 2 User Controllable Open Collector Driver
3 DC Voltage Input 0-60 V Input Voltage
4 Digital Input 1 External Input Alarm
5 Digital Input 2 External Input Alarm
6 Forward PA Shutdown External PA Control
7 Reverse PA Shutdown External PA Control
]2 1 External Tamper Input Secondary Door Open
urs 2 UPS Tamper Input External Input Alarm
3 UPS AC Fail Input External Input Alarm
4 UPS Low Battery Voltage Input External Input Alarm
5 UPS High Battery Voltage Input External Input Alarm
6 UPS Charger Failure Input External Input Alarm
7 UPS Summary Normally Closed External Input Alarm
8 N/C No Connection
J22 1 Critical Relay NO Normally Open Output
Alarm [ o Critical Relay NC Normally Closed Output
Relay 3 Critical Relay COM Common Input
4 Major Relay NO Normally Open Output
5 Major Relay NC Normally Closed Output
6 Major Relay COM Common Input
7 Minor Relay NO Normally Open Output
8 Minor Relay NC Normally Closed Output
9 Minor Relay COM Common Input
J23 1 User 1 NO Normally Open Output
User 2 User 1 NC Normally Closed Output
Relay 3 User 1 COM Common Input
4 User 2 NO Normally Open Output
5 User 2 NC Normally Closed Output
6 User 2 COM Common Input
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7.1.1 Digital User-Controlled Outputs

The repeater includes two digital outputs, each with one lead for an open-translator col-
lector. When the RepeaterNet software sets one of these digital output switches to On, the
repeater sends a voltage to the input resistor of the transistor pair, as shown in Figure 7-3.

This voltage causes the transistor to saturate. Because the transistors are configured in a
Darlington pair, the on-state saturation voltage is about 1 volt. This makes these outputs
unsuitable for driving TTL loads directly. However, these two outputs can drive any
other type of DC load, within their maximum ratings. Outputs are not isolated from the
repeater's power subsystem, and the repeater's chassis ground terminal is the ground ref-
erence point for all inputs and outputs. Each of the digital outputs has the following max-
imum characteristics.

Forward Current (IC) continuous 500 mA
Maximum collector-to-emitter voltage (VCE) 50 Volts
Collector-to-emitter saturation voltage (VCE(SAT)) 1.0V
Leakage Current in Off State (maximum) 50 pA

Figure 7-3 depicts the output circuitry of each user-controlled digital output.

Figure 7-3 User-Controlled Digital Output - Typical

r———""—"=""="=""===="="="="=""="="="7"

J1-1, or J1-2

Vce
1.0V

LY

ov

\Chassis

Ground
Terminal

RT130148

Figure 7-4 and Figure 7-5 show two typical applications for digital outputs.

Refer to the Alarm Control Status Screen in Chapter 10, Configuring the Repeater, for
instructions about activating digital outputs.
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Switching an Intrusion Alarm On and Off, Using Digital Output Number 2

Figure 7-4

Connecting External Alarms
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7.1.2 User-Controlled Relay Outputs

The repeater also provides two user-controlled relay outputs, with form C contacts. These
relays respond to user commands through the RepeaterNet software, similar to those
described above for digital outputs. When the RepeaterNet software sets one of these
relay switches to On, the transistor saturates, and energizes the relay. Figure 7-6 shows
the relay in the energized or On state.

Figure 7-6  Typical Relay Output

REPEATER
Y J23

i

Chassis
Ground
Terminal

%)
LT

RT130151

The maximum switching characteristics for each of the user-controlled relays are:

Maximum current 30 VDC @ 2 Amperes or 125 VAC @ 0.5 Ampere
Maximum switching voltage 220 VDC

* Figure 7-7 shows a circuit that uses user-controlled relay output number 2 to control
a lamp at the repeater site.

* Figure 7-8 shows a circuit that uses user-controlled relay output number 1 to control
a fan or blower at the repeater site.

Refer to the ACU Status Screen in RepeaterNet Craft, for instructions about activating the
digital outputs of a repeater.
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Controlling a Lamp, Using Relay Output Number 2

Figure 7-7
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7.1.3 Alarm Relay Outputs

You can use the RepeaterNet software t set the severity of all internal and external alarms.
The choices of severity settings are:

e (Critical
* Major
¢ Minor
* Event
Disable

Whenever the repeater generates an alarm, it also generates a summary alarm for that
severity. For example, if the repeater generates a critical alarm, it also generates a critical
summary alarm. The repeater also generates similar summary alarms for major and
minor alarms.

Each summary alarm is connected to a relay. The contacts of these alarm relays are acces-
sible through J22 on the repeater's connector panel. Figure 7-9 shows the basic internal
circuit, which is similar to the circuit for the user-controlled alarm relay outputs (see sec-
tion 7.1.2, “User-Controlled Relay Outputs” on page 7-8). When the repeater generates an
alarm, the transistor saturates and energizes the relay, as shown in Figure 7-9.

Figure 7-9  Alarm Summary Relay Output - Typical

CRITICALALARM  +V J22

SUMMARY

OUTPUT 2_<
3—<
1_<

REPEATER

=
@
- T

RT130154

Figure 7-10 shows the critical alarm summary output relay, which is controlling an exter-
nal, dual-color (green/red) LED. Normally, the relay is open, and the green LED is biased
on. When an alarm occurs, the relay closes, and the LED turns red.
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Fiqure 7-10  Critical Alarm Summary Relay, Controlling an External LED

CRITICAL ALARM +V J22 +V
SUMMARY
OUTPUT |_

K
@E@

REPEATER —
Red > < Green
v —EI—K
o [
| Chassis Ground Terminal
- - RT130155

Figure 7-11 shows circuitry that connects all alarm summary relays to external lamps,
through a flasher. This circuit provides an external indication of any internal alarm in the
repeater.
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Figure 7-11
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7.1.4 Digital Inputs
The repeater has two digital inputs, and one battery monitor input.

You can use the two digital inputs to monitor equipment or events that are external to the
repeater. You can control and process these external alarms through the RepeaterNet soft-
ware, in the same way you do for internal alarms (see section 7.1.3, “ Alarm Relay Out-
puts” on page 7-11). You can set the severity of each external alarm input.

Figure 7-12 shows the basic circuit for the external alarm inputs. The digital inputs are
accessible through connector J1 on the repeater's connector panel.

Figure 7-12  Digital Input Circuit - Typical

J1
100 Ohm 4
1
(+)
A—
Varistor
REPEATER _

RT130157

One of the most common external alarms, at a base station or a repeater site, is the failure
of a tower hazard warning light. This light, used for warning aircraft of the existence of a
tower, must be replaced immediately if it fails. Figure 7-13 and Figure 7-14 show two
ways that the external digital alarm inputs can monitor a tower light.
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Fiqure 7-13  Monitoring a Tower Hazard Light - Configuration 1

Digital Alarm Input No. 1

ol
p==

J1 P/O J1
4 / <®_
(+)
1000uf

Y

A :It! R1H

+5 VDC (MAX)
1K
0.25 Wattﬁ
Tower
Warning
Light

]
1
1
1
1
1
1
1
1
1
! Varistor
1
1
1
1
1
1 1
1
1 Lamp
! I Control
1 1
I I \ CHASSIS GROUND l l
1 —_—
1 REPEATER — TERMINAL
e o e e e e e e e e e e e . 1 | I
115-220 VAC 47 -63 Hz
VALUE FOR R1 (Ohms) LAMP SIZE
115 VAC 220 VAC (WATTS)
3.9 2W 8.2 2W 50
22 5W 4.7 5W 100
1.5 5W 3.3 5W 150
1.2 10w 2.7 5W 200
1.0 10w 1.8 10w 250
0.5 20w 1.0 10w 500
RT130159
Do not exceed the following specifications when connecting digital inputs:
Input Voltage for Logic 0 <0.5 Volts
Input Voltage for Logic 1 (active alarm/disable PA) >4.0 Volts
Maximum Input Voltage 5.0 Volts
Minimum Input Voltage 0.0 Volts
Maximum Input Current 2mA
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Fiqure 7-14  Monitoring a Tower Hazard Light - Configuration 2

AD S /
Converter N\
(+)

~oOH—
J_: \ CHASSIS GROUND TERMINAL

REPEATER

RT130160

7.1.5 External DC Input Voltage

The repeater has one analog input, to monitor an external DC power source. The moni-
toring range is from 0 to 60 volts, with a resolution of 250 mV.

1. Connect an external DC power source to the repeater, using a single lead from the
positive line/terminal of the battery to Connector J1, as shown in Figure 7-15.

2. Connect the negative lead of the battery to the repeater's chassis-ground terminal.

CAUTION: Do not allow any input to exceed the 60-Volt limit.

Figure 7-15  Typical DC Monitoring Configuration

+V

J1-6 or
J1-7 Disable
Femm————— T oy )
N\

Enable

Jumper
(Enable)

REPEATER

J— \ CHASSIS GROUND TERMINAL

NOTE: A jumper will enable the PA and disable

the PA disable function RT130161
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7.1.6 Power Amplifier (PA) External Disable Input

To disable the forward and reverse power amplifiers of the repeater, use terminal 6 (for
forward PA) and pin 7 (for reverse PA) of connector J1. If these inputs are open, or are
connected to a voltage of at least 5 VDC, the corresponding power amplifier is disabled. If
you return these pins to ground, the external disable function, itself, becomes disabled.

Figure 7-16 shows the Power Amplifier disable function.

Fiqure 7-16  External Power Amplifier Disable Function

TBD
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8.0 Introduction

Power connects to the RC1920C Primary Repeater, and to the RC1920C Growth cabinet,

through the Entry Box of the Primary Cabinet.

Table 8-1 shows the specifications for the input power.

Table 8-1 Input Power Specifications

Current Type

Power Specification

Alternating Current

115/230 Volt AC Auto-ranging, 47 to 63 Hz
(Operating Range: 86 to 268 Volt AC)

1-Channel =1.5/0.9 Amps, typical
2-Channel =2.6/1.5 Amps, typical

Direct Current

24 Volt DC, -3/+6 Volts

1-Channel = 6.0 Amps, typical
2-Channel =10.2 Amps, typical

NOTE: The RC1920C Repeater is available, from the factory, as either an AC-powered or
DC-powered unit. Repeater Technologies does not supply any AC to DC, or DC to AC,

field conversion options.
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8.1

AC Power Wiring for Primary Cabinet

The following sub-sections describe how to connect AC power to the primary repeater
cabinet.

8.1.1 Inside Wiring

For installations that are located inside of a building (in a protected area), connect the AC
input power to the Repeater. A standard 8-foot long North American NEMA 15-5 (three
prong) AC line cord is included with the Repeater Accessory Kit. You can substitute a
longer cord if needed. Figure 8-1 shows a typical installation.

WARNING: If the line cord is not connected, and plugged into the repeater receptacle,
exactly as described and illustrated in this section, the repeater can be phys-
ically damaged, and anyone operating or servicing the repeater can be
injured by electrical shock.

Figure 8-1  Typical 2-Channel Horizontal Wall Installation

TBD

1. Feed the power cord through the 1/2" plastic strain-relief.

The strain-relief is a water-tight plastic connector, provided to relieve strain on the AC
power cord. This connector is included in the Repeater Accessory Kit. Figure 8-2 shows
how to install the strain-relief.
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Fiqure 8-2  Installing the Plastic Strain-Relief Conduit

B To AC commercial
power plug

To entry box—l

RT113907

2. Insert the strain-relief for the AC power cord, into the Entry Box of the main repeater
cabinet, as shown in Figure 8-3.

Insert the cord into the upper-left conduit opening, as shown in Figure 8-3 and Figure 8-4.

Feed the stripped and tinned end of the line cord through the plastic strain-relief, so that
approximately 6 inches of line cord is inside the Entry Box opening.

Fiqure 8-3  Installing AC Power Cord and Strain Relief into Entry Box

TBD
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Fiqure 8-4  Power Cord Installation

TBD

3. Slide the 1/2" Lock Nut for the conduit onto the strain relief. Tighten it until it is

snug, but still fits loosely. Refer to Figure 8-5.

Fiqure 8-5  Lock Nut Installation

TBD

4. Install the AC In power plug onto the power cord, as shown in Figure 8-6.

Use the small screwdriver to terminate the black (hot) and white (neutral or common)

stripped leads, on the AC line-cord plug.

84
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Fiqure 8-6  AC In Power Plug for Primary Cabinet

Green (or Green-Yellow) - Spade terminal

l

Top Connector is
not used —I

White (neutral or common)

wire is in the middle J g

Black (Hot wire) / 3

is in the bottom v

RT113908

5. Connect the green (ground) wire spade-terminal to the ground lug.

6. Plug the AC In power plug into the J18 receptacle (see Figure 8-5, Figure 8-7 and
Figure 8-8).

NOTE: Plug the power cord into a dedicated wall outlet that is hard-wired to a circuit
breaker. The circuit breaker must be 10 to 15 Amps for 115-Volts AC service, or 7.5 to 10
Amps for 230-volt service, and must be dedicated exclusively to the repeater.

Fiqure 8-7  Location of J18

TBD
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Fiqure 8-8  Entry Box for RC1920C Primary Cabinet

TBD

7. After connecting the repeater and closing the circuit breaker, turn the repeater On,
using the Repeater Power Switch.

NOTE: RTI provides standard North American color-coded wires (white, black, and
green). For international 230-Volt AC, 50 Hz applications, if local code requires the use of
an international color-coded line cord (blue, green, and green-yellow), and requires the
use of a country-specific power plug, you must obtain the wiring and plug locally. RTI
does not provide international color-coded wiring or country-specific power plugs.

Table 9-2 lists the conversions from North American to international wiring color-codes.

Table 8-2 Power Cord Conversion
Wire Description North America International
AC (Hot) Black Brown
Neutral (Common) White Blue
Ground (Grd) Green Green-Yellow

8-6
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8.2

8.1.2 Outside Wiring
If the repeater is outside, use the following procedure:

1. Install the repeater power, using 1/2" Liquidtight flexible conduit, and the appropri-
ate Liquidtight conduit fittings.

2. Wire the repeater using #16 AWG (or larger) stranded PVC wire.
Number 16 Gauge wire complies with most local and national electrical codes, because

the Repeater Power Switch is also a thermal-magnetic circuit breaker, which limits cur-
rent to a maximum of 10 Amps.

NOTE: You can use larger-gauge wire, but it might be difficult to install the larger wire
into the AC plug, provided with the repeater.

DC Power Wiring

You can connect 24-Volt nominal Direct Current power to the repeater, from either of the
following DC power sources:

* A fixed 24-Volt DC Cell Site-type power system

* A Repeater Technologies BUPS-25/80 Back-up Power System (RTI part number 250-
1011-01), or equivalent

8.2.1 DC Supply From a Fixed Cell-Site Power Plant
If a fixed power plant provides DC power to the repeater, use the following procedure:

1. Connect the repeater to the DC power via a dedicated fuse or circuit-breaker.
* Use a 10-Amp fuse or circuit breaker for a single-channel system.
* Use a 15-Amp fuse or circuit-breaker for a two-channel system.

2. To plan for growth, wire the Primary cabinet to support future addition of a Growth
Cabinet.

To support this growth, use #10 AWG stranded wire for power cables under 20 feet long,
or a larger wire gauge for runs of 20 feet or more. Consult your local or national electrical
safety codes for the appropriate wire sizing.

3. Use1/2" flexible PVC conduit to bring the wire into the Repeater Entry Box, through
the left-most 1/2" conduit knockout.

NOTE: You must provide the junction box, from which the DC cable leads into the
repeater.

Figure 8-9 and Figure 8-10 show the typical DC Entry Box layout, and the recommended
wiring.
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Figure 8-9  RC1920C DC Entry Box, Front View, with Cover Removed

TBD

Figure 8-10  RC1920C DC Entry Box, Front View, with Cover Removed

TBD
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8.2.2 Back-up Power Supply

A typical Back-up Power Supply (BUPS) consists of a charger/rectifier, and has 24-Volt
batteries floated across the charger/rectifier output. The capacity of the BUPS should be
sufficient to handle the addition of a Second Channel or Growth Cabinet.

Figure 8-11 shows a block diagram of the BUPS from Repeater Technologies, Inc. (RTI).
* The RTI BUPS-25/80 rectifier supplies 25 Amperes of continuous current at 24 Volts

DC.

* The two internal 100 Amp-Hour batteries are sized to provide 80 Amp-Hours of ser-
vice without AC power.

* For a one-channel RC1920C, the BUPS-25/80 provides approximately 13 hours of
back-up without AC power.

* For a two-channel system, the BUPS-25/80 provides approximately 8 hours of back-
up.

For more details about the RTT BUPS, see the RTI BUPS-25/80 Operation Manual, Docu-
ment Number 550-1011-01.

Fiqure 8-11  Simplified BUPS-25/80 Block Diagram, RTI P/N 250-1011-07

Rectifier / Charger

Ckt Bkr

Ckt Bkr

O -----

|
|
|
I
|
|
Current O
K ! and | Zzll
! Voltage 1 Volts
ll\?/izc?’o (‘3 Regulation C?
(switchable) Cireuit \
— |
! |
K O——| 1
! |
! Ckt Bkr
N 77 .
! |
|
| |t T
! —_ - 12Volt ! Repeater
: E— Batteries :
|
| I S e |
! |
! |
: Monitors and Alarm Circuitry with !
| Indicators and Relay Outputs é) Alarms
]

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

RT116901

Position the BUPS, and the RC1920C Network Repeater, with sufficient spacing for hard-
ware access, and to allow the addition of a Growth Cabinet. Figure 8-12 shows the layout
that RTI recommends.
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Fiqure 8-12  Recommended Mounting of Primary/Growth Cabinets, with BUPS-25/80

TBD

Figure 8-13 shows how to connect the BUPS-25/80 to the RC1920C repeater. Figure 8-15
shows the dimensions of the RTI BUPS-25/80 unit.

NOTE: The RTI BUPS-25/80 Back-up Power Supply includes the 1/2" Liquidtight flexi-
ble steel conduit, the power and alarm wiring, and the necessary Liquidtight conduit fit-
tings to connect the repeater to the BUPS.
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Figure 8-13

Wiring Connections from RC1920C Network Repeater to BUPS-25/80

OAB850C/OA1900C Network Repeater to BUPS-25/80 Wiring Kit

Tie back Leads if door

BUPS 25/80 i i OA850C/OA1900C NETWORK
CHARGER TERMINAL alarm is not available, REPEATER TERMINAL BLOCK
BLOCK Tamper Alarm in
J1
_— (IN/OUT)
comef}-BLK H '] 1 - Digital Output 1
SUMM OK <y RED 2 - Digital Output 2
|@[FAIL 3- DC Voltage Input (Monitor)
COM > 4 - Digital Input 1
OPTION § OK 5 - Digital Input 2
FAIL 6 - Forward PA Shutdown
- hd 7 - Reverse PA Shutdown
HIGH [@] comM <} BLK J2 (UPS)
DC OK = 1 1 - External Tamper Alarm (Secondary Door Alarm)
VOLT |@]FAIL WHT > 2 - UPS Tamper Input (External Input Alarm)
Low [@]com<e—p-BEK > 3 - UPS AC Fail Input (External Alarm)
DC OK = ] > 4 - UPS Low Battery Voltage Input (External Input Alarm)
VOLT FAL YV GRN 11N 5 - UPS High Battery Voltage Input (External Input Alarm)
N . o\ BLK H—> 6 - UPS Charger Fail Input (External Input Alarm)
C'EEE 8%’\" < |—-—> 7 - UPS Summary Normally Closed (External Input Alarm)
'AC EAL Y BLU 2] 8- UPS Summary Com (Protected Ground)
(2] com<—f-BLK ' . ) .
OKM < 8 Ft. Belden 8743m 22 AWG Solid, 6 Twisted Pairs, PVC Insulation, 150V
FAIL VYEL 80 deg., Jacket cut back 4”, conductor ends stripped back 1/4”, Grd. Lug
FAIL L L —1 and terminated in single yellow #10 spade terminal, (Part of RTI Part No.
GRD |@|com |1 187-0188-01, Power & Alarm Cable Assembly, included with the RTI
FAIL I%L / BUPS-25/80 product).
= & BRN -
Door - future | 1] 1] Legend:
- v BLK #22 AWG
O+ *1Two —_—
BATT |@|- T Batteries #10 AWG
. 6 +: + M[/)-\(|:N —( #10 AWG Spade Term.
1 S
117/220 VAC Q|- J Q@] . pUT )>—— #6 AWG Spade Term.
INPU(':I' 1oL szf\slziﬁsGDrqui and #10-12 AWG Pin Term.
— - Ie . .
Neutral Q N L 5 common in repeater <—— Stripped-back and Tinned
__GRD EN GRD
Ground LUG . D, ) v} > LUG

6 1/2" Liquidtight Flex Conduit —f

8 Ft. Royal W0781, 10 AWG, Stranded, PVC Insulation, 300V -60 C, OA850 or OA1900
ends stripped back 0.3” and tinned, BUPS ends stripped-back and terminated with #10
Spade Term. (part of RTI P/N 187-0188-01, BUPS Power & Alarm Cable Assembly,
included with the RTI BUPS-25/80 product).

RT130165

You must locally obtain the AC input conduit and wiring for the BUPS. Make sure that
the conduit and wire size comply with local electrical and safety codes. The following are
typical BUPS-25/80 input voltage and current specifications:

115 Volts AC @ 9 Amps
230 Volts AC @ 4.5 Amps

CAUTION: Before starting to wire the BUPS, verify that all input power and circuit
breakers are in the Off position, for both the RC1920C repeater and the BUPS.

550-3100-01 Rev A
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Circuit Breaker Sequence for Using the BUPS with an RC1920C Repeater

1.
2.

Install the two 12-volt Gel Cell batteries.

Use the wires provided with the BUPS, to connect the batteries to the BUPS Rectifier.
Figure 8-14 shows the front panel of the BUPS Charger-Rectifier.

Verity the battery voltage at the BUPS Rectifier terminal block, using a multi-meter.
The multi-meter should read approximately 25 to 27 Volts.

Close the BUPS AC Input Breaker.

Close the BUPS Charger Circuit Breaker.

Close the Battery Circuit Breaker.
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Fiqure 8-14  Front Panel of the BUPS-25/80 Charger-Rectifier

Alarm LEDs
@
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38 e
L m IS
I
IS -
) _
08 T
© [V
g€ %o
4 O <
s
5,
Q
540 5
c - £
n T O
c
2
=
o
(@]

D

Input @] com
Voltage summ| @ |ok
Select o | FAIL
[@]com
OPTION|@ |ok
L2 |FAIL
N/C
+ HIGH[@ ] COM
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Charger
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(]
AC Input
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Battery
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7. Verify the voltage using the BUPS Test Terminals.
The multi-meter should read approximately 27 Volts.

8. Close the RC1920C Power Switch.
Observe the Repeater load (Amps), using the BUPS Load Test Terminals.

RT117902
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Under normal conditions, the load should be approximately 6.0 Amps for a Primary
Channel, and 10.2 Amps with a two-channel system (Primary and Growth Cabinets).

Figure 8-15  RTI BUPS-25/80 Dimensions

TBD

Table 8-3 provides the typical back-up time that a repeater can operate without AC. The
worst-case battery recharge time, as measured from the low-voltage (below 21 volts) cut-

off-point of a rectifier, is 8 to 9 hours.

8-14
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Table 8-3 Back-up Power Support, Using RTI BUPS-25/80 Back-up Power System

Typical RTI RC Repeater Back-up Time, Without AC/Commercial Power

Repeater RF Output | ACInput | DC Input Back-up Back-up Power System

Configuration Power Power Current Time
ACP @ Watts @ Amps @ Hours Model RTI Part#
Antenna 117 volts 24V
Port AC

OAS850C, 7 180 6 13.3 BUPS-25/80 250-1011-07
1 channel
0S850C, 14 310 10.2 7.8 BUPS-25/80 250-1011-07
2 channels
OA1900C, 6.3 205 7.5 10.6 BUPS-25/80 250-1011-07
1 channel
OA1900C, 12.6 350 12.8 6.3 BUPS-25/80 250-1011-07
2 channels

8.3

NOTE: For solar-power applications, whenever the repeater is not handling any CDMA
traffic (only pilot, paging, and sync channels), the repeater enters Power-Save Mode,
reducing power consumption by 20%.

Additional Back-up Without AC Power

If the repeater requires longer electrical-power back-up time, contact the Customer Ser-
vice Department at Repeater Technologies, for more information.

Grounding

Installing the input power to the repeater includes installing the standard electrical ser-
vice grounds. However, you must also make sure that the RC1920C Cabinet/Chassis is
properly grounded to a water pipe or earth ground.

Each repeater cabinet (Primary/F1 and Growth/F2) includes two external grounding
lugs: one on the repeater cabinet, and one on the Entry Box under the cabinet, as shown
in Figure 8-16.

550-3100-01 Rev A
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Fiqure 8-16  Location of Ground Lug on Primary Cabinet

TBD

1. Connect number 6 (or larger) gauge AWG solid wire to each ground lug.

2. Carefully dress the wire along cabinet, and the mounting surface, to the Repeater
Grounding System or the Ground Rod.

NOTE: When dressing the grounding wire, and forming it around corners, avoid mak-
ing sharp bends in the wire. Use a generous radius for each wire bend.

For more information about grounding repeaters, consult the RTI Application Note titled
Installation Standards for Ground Requirements, Document Number 650-0002-01, Rev. 2.

8.3.1 Grounding the BUPS-25/80

Ground the Back-up Power Supply (BUPS) in a manner similar to a repeater cabinet.
However, you must also add an external chassis ground lug to the BUPS-25/80, at the
same time that you install the electrical service.
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9.0 RepeaterNet Craft Software

The RepeaterNet Craft software (Craft) provides configuration management and alarm
monitoring capabilities for individual repeaters from Repeater Technologies, Inc. (RTI). It
also dynamically manages repeater maintenance sessions in real time, through one of
these connections:

* A laptop computer with a direct connection to the repeaters - a technician can visit

repeater sites and connect to the repeaters directly, using the serial port on the lap-
top.

A laptop or desktop computer with a modem connection to the repeater - a techni-
cian can use the modem to connect to the repeaters, without visiting the physical
repeater sites.

The Craft software can operate under either Windows 95 or WindowsNT. The Craft user
interface varies, depending on the model of repeater that the software is configuring or
monitoring.

91 Minimum System Requirements

Craft system requirements include:
Pentium 120 MHz, running Windows 95, with 32 Mb of memory

If you are using the Craft system with Windows 95, you must use the Microsoft Ser-
vice Pack 1 Update (Version 4.00.950 A) or later releases.

If you are using the Craft system with WindowsNT, you must use the Microsoft Ser-
vice Pack 3 Update.

Approximately 10 Mb of free disk space

Modem (if a modem connects the laptop to the repeater)

NOTE: Use Hayes-compatible modems only. RTI repeaters are Connect with Rockwell
certified, for modems of 56k or above. US Robotics modems are not supported.
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If the PC or laptop uses a fax program, such as Microsoft Fax, make sure that the Auto
Answer feature is disabled. See Appendix B, Troubleshooting (Problem 7) for how to dis-
able Auto Answer for Microsoft Fax.

9.2 Installation Procedure
The RepeaterNet Craft software is distributed on 4 High Density (HD) floppy disks. To
install this software, use the following procedure.
1. Insert Disk 1 into the a: drive.
2. From the Windows Start menu, select Run.
3. Type a:\setup and click on the OK button.
4. Follow the online instructions to install the Craft software.
The Craft software includes default configuration files, which you can download to the
repeater. You can download the appropriate file for the repeater type, and for the number
of channels, instead of manually configuring the repeater's properties.

9.3 Configuring the Repeater Connection
You must use the RepeaterNet Craft Admin program to configure the connection to the
repeater, before you can access the RepeaterNet Craft software.
Follow the path in Figure 9-1 to invoke the RepeaterNet Administrator from the Start
menu.
Figure 9-1  Starting the RepeaterNet Administrator

48 Ster B8 Admin
Craft
RepeaterNetCraft
RT131101

When you invoke the Administrator, RepeaterNet displays the window shown in
Figure 9-2.
You can save both Direct and Dial-Out (Modem) configurations, but you must assign a
unique COM Port Number to each. Also, you can check Use this connection for only one
of the configurations. The RepeaterNet Craft software uses the selected connection to
connect to the repeater.
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Fiqure 9-2  RepeaterNet Admin

" RepeaterMet Craft Admin x|
Direct Connection
COM Port Number 0
Cancel
W' Use this connectian 4
odem Connection
Save
COM Port Number B
Fhone Murmnber 555-1212
[ Use this connectian
RT131102

For example, you might do the following:

1. Assign the connection type as Direct through Com Port 1.
2. Check the Use this connection box, to make this the default configuration.
3. (Click on the Save button.

Next, you can save a Modem configuration to another Com port, such as Com Port 2:

1. Assign a Com Port Number that is different from the Com Port Number used for the
direct connection.
2. Click on the Save button.

3. Click on OK to exit RepeaterNet Admin.
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9.4

Starting Craft
Double-click on the Craft icon.

The window in Figure 9-3 displays.

RepeaterNet connections to the repeater, and displays the Craft Main Control screen for

the repeater, as shown in Figure 9-3.

Figure 9-3  RepetaerNet Craft Window

ir Untitled - Repeaterbet
File  Help

Pedecting Wireiess Coverage Worlidwide

Connecting to Repeater...

RT131103

9-4
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9.5 RepeaterNet Craft Main Control Screen

The Craft Main Control screen provides access to all monitor and control functions of the
Network Repeater (NR).

Main Control screen icons (shown in Figure 9-4) provide access to both subsystem status
screens, and report alarms.

Fiqure 9-4  RepeaterNet Craft Main Control Screen

4i7 CDOMA Repeater 0A1900
Fil=  Configuration  System  Options  Help
Forward
Forward Channel 1
Front End _— — . ’ <«———— Forward Power
Amplifier
Channel 1 Channel 2
Forward Channel . <———— Forward Power
Select Filter Amplifier
Channel 2
Forward Channel Channel 1
Select Filter Reverse Reverse Channel
| Select Filter
Channel 1
Reverse Power ————» <+—1— Reverse Front End
Amplifier
Channel 2 <— Diversity Front End
Reverse Power ————»
Amplifier
- Channel 2
Alarm Control Unit — ‘:‘ N : ‘* I Reverse Channel
B ; Select Filter
? - ? Connector Indicator
Alarm Stats of the Alarm Corjtrol Linit. » < (green=connected,

red=not connected)

Modem  Cell Phone Power Supply ~ Back-up Power
(AC) Supply (BUPS)
RT131104
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Fiqure 9-5  RepeaterNet Craft Pull-down menus

Download Properties Front End
Upload Properties
Channel 1

Update Firmware

Exit

Alarm Control Unit
Modem/Pager
Cellular Phone

Fower System
UPS

Hardware Setting

Properties...
Alarm and Event Log b

Befresh Alarms

Test Alarm Dial Out Setup

Color Independent Icons
Alarm Sounds
v Hold Connection

Help Topics

About...

RT131105

NOTE: All RTI repeaters are shipped with PAs (Power Amplifiers) turned Off. In this
condition, the PA Off indicator (a circle with a slash through it) displays over each PA
subsystem icon (FPA and RPA) in the RepeaterNet Craft Main Control Screen (not shown
in Figure 9-4). Keep each repeater's PA turned Off, until you have adjusted the gain for

that repeater.

NOTE: The appearance of the Main Control Screen might vary from that shown in
Figure 9-4, depending on the hardware configuration of the repeater unit. For example,
Channel 2 icons are grayed-out (unavailable) for a single-channel repeater.

9-6
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9.5.1 Subsystem Configuration

To configure the repeater, select the subsystem Properties screens from the Craft Configu-

ration menu.

Table 9-1 lists the choices in the Configuration menu.

Table 9-1

Configuration Menu

Menu Selection

Description

See Section

repeater has the Cellular option.

Hardware Setting To configure the repeater for addinga | Section 9.9, “Hardware Settings” on
growth cabinet, a mode or a cell page 9-12.
phone

Front End Configures the Forward, Reverse, and | Section 9.10, “Front End Proper-
Diversity front end ties” on page 9-12.

Channel 1 Configures repeater channel 1. Avail- Section 9.11, “Channel Properties”
able on all units. on page 9-14.

Channel 2 Configures repeater channel 1. Avail- Section 9.11, “Channel Properties”
able on 2-channel units only. on page 9-14.

Alarm Control Unit Configures ACU. Section 9.12, “ACU Properties” on

page 9-22.

Modem Configures internal or external Section 9.13, “Modem Properties”
modem. on page 9-29.

Cellular Phone Configures internal cell phone, if the Section 9.14, “Cell Phone Proper-

ties” on page 9-36.

Power System

Configures input, battery, and internal
power.

Section 9.15, “Power System Prop-
erties” on page 9-38.

Uninterruptable Power
Supply (UPS)

Configure Back-up Power System
(BUPS).

Section 9.16, “Back-up Power Sys-
tem (UPS) Properties” on
page 9-40.

Hardware Setting

Configures Growth Box Modem Cell
Phone
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9.6 Status Reporting

After configuring the repeater, you can use the subsystem Status screens to monitor and
control repeater system functions. For example, when a repeater alarm triggers, the
appropriate subsystem icon for the type of alarm changes appearance, and starts blink-
ing. An audible alarm also activates.

1. Click on the subsystem icon for the type of alarm that triggered.

The appropriate status screen opens. The icon stops blinking, and the audible alarm
stops. This acknowledges that you are aware of the alarm condition. However, the
icon remains changed to its alarm configuration.

2. Fix the problem that triggered the alarm.

After you clear the alarm condition, the display of the icon reverts to normal.

The display of the Forward PA and Reverse PA icons indicate the operational status of the
Power Amplifiers. If a PA is Off, a circle with a slash displays over the associated icon.

If a subsystem is not available to the repeater, RepeaterNet displays that subsystem as
disabled. For example, if a repeater has no cellular phone, the cellular icon is light gray.
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9.6.1 Alarm Status Reporting on the Main Control Screen

RepeaterNet uses a color system to report subsystem alarm status on the Main Control
screen. Table 9-2 shows the meanings of the colors, and of any corresponding color-inde-
pendent icons.

Table 9-2 Alarm Icons

Subsystem Alarm Statue Icon Color Color Independent Icon Action
Normal - No Alarm Green N/A N/A
Critical Alarm Red X through icon Call Out
Major Alarm Yellow Back slash through icon Call Out
Minor Alarm Blue Dotted line slash through icon | Call Out
Event White None None
Disabled Dark Gray* N/A None
System Not Available Light Gray N/A N/A
* If all alarms in a subsystem are disabled or set to event severity, the icon color is dark gray.

When an alarm is triggered, the icon color of the affected subsystem changes, from green
(normal), to the color of the alarm definition, and the icon blinks.

RepeaterNet also offers two optional alarm features:

* The Color Independent Icons feature is provided for operators who are unable to dis-
tinguish color.

¢ The Alarm Sounds feature adds an audible alarm.

If an individual subsystem triggers more than one alarm, the Main Control Screen reports
the higher-severity alarm, in both the color and color-independent icons.

For example, if both a major and a minor Reverse PA alarm trigger, a yellow subsystem
icon is reported. If you clear the major alarm while the minor alarm remains active, a blue
subsystem icon is required.

NOTE: When a subsystem alarm triggers, click the icon (to open the status screen). This
action terminates the icon blinking feature, and silences the audible alarm. However, icon
color continues to report, and a color-independent icon (if applicable) continues to dis-
play until you clear the condition that triggered the alarm.

Color reporting does not apply to subsystems that are set to Event severity.
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9.7 Defining Alarm Severity

The repeater is factory-configured with a standard set of alarm severity settings. You can
use the subsystem Properties screens to adjust alarm severity, from these defaults. See
Section 9.8, Configuring Repeater Properties, for more information about alarm severity
and the factory configuration.

The levels of alarm severity are:

e (Critical
* Major

¢ Minor

¢ Event
Disabled

To define alarm severity, use the following procedure.

1. Login to a session with the repeater.

2. Select Configuration from the Main Control menu bar, then select a subsystem, to
open its Properties screen.

For example, select Configuration -> Channel 1. The Alarms tab displays.
For actual screen examples, see Section 9.8, “Configuring Repeater Properties” on
page 9-11.

3. Click the down-arrow next to an Alarm field, to select a new alarm severity.

4. Click the Apply or OK button to change the alarm severity.

The Apply button changes the alarm severity, and keeps the Channel Properties
screen open.

The OK button changes the alarm severity, and closes the Channel Properties screen.
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9.8

Configuring Repeater Properties

Use the subsystem Properties screens to configure the repeater.

To open a Properties screen, select one of the following subsystems from the Configura-
tion menu:

* Front End

e Channel 1

* Channel 2

* Alarm Control Unit

* Modem

* Cellular Phone

* Power System

» UPS

* Hardware Settings

The Properties screens display tabs that are specific to each subsystem.

NOTE: Screens shown in this manual might not exactly match what you see on the PC or
laptop.

You can configure two types of repeater properties:

* Redefine alarm severity

* Specify operational settings for the repeater

NOTE: Some subsystem Properties screens include tabs for redefining alarm severity,
and for specifying operational settings. Others have a single tab, for redefining alarm
severity.
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9.9 Hardware Settings

Use the Configure -> Hardware Setting screen (see Figure 9-6) to inform RepeaterNet
when you add one or more of the following to the repeater configuration:

¢ Growth Box

e Modem
¢ Cellular Phone

Figure 9-6  Hardware Setting Screen

Hardware Setting
GrowthBox Configuration

[v GrowthBaox is attached

Modem or UART Configuration
[ Modem or UART is attached

Cell/FCS Phone Configuration
[ Motorala Elite phone is attached

Select Phone p

Cancel

RT131106

9.10 Front End Properties

The Front End Properties screen configures the Front End subsystems. This screen
includes tabs that set the alarm severity for:

* Forward FE

* Reverse FE

* Diversity FE

NOTE: Do not adjust power amplifier gain while any of these alarms are active.
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9.10.1 Forward FE Tab
The Forward FE tab (see Figure 9-7) sets the alarm severity of the Forward FE alarm.

The Forward FE alarm becomes activated when the forward signal power level is too
strong, and is being attenuated to protect the repeater from possible damage.

Figure 9-7  Front End Properties Screen, Forward FE Tab

Front End

Fud FE | Rev. FE | Diversity FE |

Alarmn Description | Severity ]
FidFE Summary Alarm Properties tinar -

QK. | Cancel Help

RT131107

9.10.2 Reverse FE Tab
The Reverse FE tab (see Figure 9-8) sets the alarm severity of the Reverse FE alarm.

The Reverse FE alarm becomes activated when the reverse signal power level is too
strong, and is being attenuated to protect the repeater from possible damage.

Fiqure 9-8  Front End Properties Screen, Reverse FE Tab

Front End

Fwd FE Fev. FE | Diversiy FE |

Alarm Description | Severnty I
FievFE Summary Alarm Properties Finor -
FievFE Overload Alarm Properties Ewvent -

oK | Cancel Help

RT131108
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9.10.3 Diversity FE Tab
The Diversity FE tab (see Figure 9-9) sets the alarm severity of the Diversity FE.

The Diversity FE alarm becomes activated when the Diversity Receive signal power level
is too strong, and is being attenuated to protect the repeater from possible damage.

NOTE: Do no adjust power amplifier gain while this alarm is active.

Fiqure 9-9  Front End Properties Screen, Diversity FE Tab

Front End

Fwd FE | Rev, FE Diversiy FE |

Alarm Description ] Severity |
DivFE Summary &larm Properties tdiror -

0K | Cancel Help

RT131109

9.11 Channel Properties

From the Main Control screen menu bar, select Channel 1 or Channel 2 (for two-channel
repeater units only), to open a Channel Properties screen. Channel properties include:

e Reverse PA
Forward PA
PA Control

Reverse Filter

Forward Filter
Channel #

e Gain
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9.11.1 Channel Reverse PA Tab

The Reverse PA tab set the alarm severity for the following types of Reverse Power
Amplifier alarms (see Figure 9-10):

Reverse PA Alarm - Indicates a failure in the power amplifier. The PA is inoperative and
the repeater is off the air.

Reverse PA Thermal Alarm - Indicates that the system temperature has exceeded the
alarm threshold. The repeater has shut down the Power Amplifier. When the temperature
is again within subsystem tolerances, the repeater automatically reactivates the PA.

Reverse PA External Shutdown Alarm - Indicates that the repeater has shut down the
Power Amplifier, and has activated one RPA (Reverse Power Amplifier) alarm. RTI rec-
ommends disabling this alarm.

To redefine alarm severity for the Reverse PA subsystem, using this tab:

1. Click the down-arrow next to an Alarm field to select a new alarm severity.
2. Click the Apply or OK button to change the alarm severity.

* The Apply button changes the alarm severity and keeps the Channel Properties
screen open.

* The OK button changes the alarm severity and closes the Channel Properties screen.

Figure 9-10  Channel Properties Screen, Reverse PA Tab

Channel 1 Properties

Riev. P4 | Fud P4 | P4 Control | Riev. Fiter | Fiud Fiter | Chanrel # | Gain |

Alam Description I Sewverity |
RevPAl Summary Alarm Properties Miror -
RevPAl Ext. Shutdown Alarm Properties b ajor -
RevPal ALC Alarm Properties Digzabled -

(5] | Cancel Apply Help

RT131110
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9.11.2 Channel Forward PA Tab

The Forward PA tab (see Figure 9-11) sets the alarm severity for the following types of
Forward PA alarms:

Forward PA Alarm - Indicates a failure in the power amplifier. The PA is inoperative, and
the repeater is off the air.

Forward PA Thermal Alarm - Indicates that the system temperature has exceeded the
alarm threshold. The repeater has shut down the Power Amplifier. When the temperature
is again within subsystem tolerances, the repeater automatically reactivates the PA.

Forward PA External Shutdown Alarm - Indicates that the repeater has shut down the
Power Amplifier, and has activated one FPA (Forward Power Amplifier) alarm. RTI rec-
ommends disabling this alarm.

To redefine alarm severity for the Forward PA subsystem:

1. Click the down-arrow next to an Alarm field to select a new alarm severity.
2. Click the Apply or OK button to change the alarm severity.

*The Apply button changes the alarm severity and keeps the Channel Properties
screen open.

*The OK button changes the alarm severity and closes the Channel Properties
screen.

Fiqure 9-11  Channel Properties Screen, Forward PA Tab

Channel 1 Properties

Fiev. P4 Fwd PA | Pa Control | Flev. Fiter | Fiud Fiter | Channel # | Gain |

Alarm Description J Severnity |
FwdPAT Surmmary &larm Properties Dizabled -
FindP&] Ext. Shutdown Alarm Properties Dizabled -
FrdPa] ALC Alarm Properties [izabled -

k. | Cancel Applhy Help

RT131111
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9.11.3 Channel PA Control Tab
The PA Control tab provides a switch to turn PA power On or Off (see Figure 9-12).

1. Click on the value in the Reverse PA Power box, and in the Forward PA Power box to
change the value.

The icon toggles between On and Off.
2. Click on the Apply or OK button for the setting to take effect.

*The Apply button changes the PA value, and keeps the Channel Properties screen
open.

*The OK button changes the PA value, and closes the Channel Properties screen.

Fiqure 9-12  Channel Properties Screen, Channel PA Tab

Channel 1 Properties

Rew. P4 | Fwd P& | 1| Riew. Fiter | Fwd. Fiter | Channel # | Gain |

Reverse PA Power Fanward Pa, Power

ak. | Cahicel

RT131112
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9.11.4 Channel Reverse Filter Tab

The Channel Reverse Filter tab sets the alarm severity for the Channel Reverse Alarm. A
failure in the Reverse Filter assembly triggers a CSF Reverse Filter alarm, and the filter
becomes inoperative.

To redefine alarm severity for the Reverse Filter subsystem:

1.

Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:

Disabled

Event

Minor

Major

Critical

Click the Apply or OK button.

The Apply button changes the alarm severity setting and keeps the Channel Proper-
ties screen open.

The OK button changes the alarm severity setting and closes the Channel Properties
screen.

NOTE: The Channel Reverse Filter tab is similar to the Channel Forward Filter tab,
shown in Figure 9-13.
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9.11.5 Channel Forward Filter Tab

The Channel Forward Filter tab (see Figure 9-13) sets the alarms severity for the Channel
Forward Alarm. A failure in the Forward Filter assembly triggers a CSF Forward Filter
alarm, and the filter becomes inoperative.

To redefine alarm severity for the Forward Filter subsystem:

1. Click the down-arrow next to an Alarm filed to select one of the following alarm
severity settings:
*Disabled
*Event
* Minor
* Major
*Critical
2. Click the Apply or OK button.

*The Apply button changes the alarm severity setting and keeps the Channel Prop-
erties screen open.

*The OK button changes the alarm severity setting and closes the Channel Proper-
ties screen.

Fiqure 9-13  Channel Properties Screen, Channel Forward Filter Tab

Channel 1 Properhies

Rev. P4 | Fwd. P4 | P& Control | Rev. Filter | Chanrel # | Gain |

Alarmn Description ] Severity |
FwdCSF1 Summary Alarm Properties Dizabled -
FiwdC5F1 Lock Alarm Properties Dizabled -

0Ok | Cancel Help

RT131113
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9.11.6 Channel # Tab

The Channel # tab (see Figure 9-14) sets the operating channel (or band), for either Chan-
nel 1 or Channel 2.

After you select a channel, the Channel Properties screen displays the corresponding fre-
quencies.

NOTE: Consult your network administrator, or the system Site Plan, for the proper chan-
nel or band setting.

Figure 9-14  Channel Properties Screen, Channel # Tab

Channel 1 Properties

Rew. P4 | Fwd P4 | P4 Control | Rew. Fiter | Fud. Fiter Channel # | Gain |

Channel Mumber Kl
Forward Frequency [MHz) 22063
Reverse Frequency [MHz] 83558

QK. | Cancel

RT131114
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9.11.7 Channel Gain Tab

The RepeaterNet software detects the configuration of the repeater, and displays the
applicable gain range on the Gain tab (see Figure 9-15). You can adjust the Forward and
Reverse gain for the selected channel.

The adjustable gain range depends on the type of repeater, and the power level of the
repeater's power amplifiers. RepeaterNet limits your choice of gain adjustments to selec-
tions that are valid for the specific repeater type and power level.

NOTE: Carefully balance the gain in any repeater application, to ensure proper hand-off
and system operation.

To adjust Forward PA or Reverse PA gain:

1. Select Configuration -> Channel 1 or Configuration -> Channel 2 to open the Chan-
nel Properties screen.

2. Click the Gain tab (see Figure 9-15).

3. Press, hold and drag the mouse across the horizontal sliders to define forward and
reverse gain.

NOTE: Gain adjusts in 2 dB increments.

The gain value box (centered under each slider) displays the selected gain.
4. Click the Apply or OK button.

*The Apply button changes the gain setting and keeps the Channel Properties screen
open.

*The OK button changes the gain setting and closes the Channel Properties screen.

Figure 9-15  Channel Properties Screen, Channel Gain Tab

Channel 1 Properties
Rev. P | Fud P4 | PA Control | Rew. Fiter | Fud Fiter | Channel # Gain |

Forward
E5 dB 95 dB

95
Beverse
E5 dB 95 dB

95

] I Cancel

RT131115
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9.12 ACU Properties

The Alarm Control Unit (ACU) subsystem provides alarm and control functions for the
repeater. The ACU monitors all repeater subsystems, and reports the status of a sub-
system, either to a directly-connected device, or to remote devices (through a dial-up
modem connection).

In addition to monitoring the repeater system, the ACU contains a number of external
inputs and outputs, for monitoring and controlling external devices.

To monitor and control a repeater's alarms:

1. Select Alarm Control Unit from the Configuration menu, in the Main Control Screen.
The Alarm Control Unit Properties screen opens.
2. Select one of the following ACU tabs:
*1/O Descriptions
*I/O Control, Alarms
*I/O Voltage Alarm Threshold
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9.12.1 ACU I/O Descriptions Tab

RepeaterNet can monitor two digital alarm inputs, and one DC voltage input from exter-
nal devices. Up to four external devices (two relay outputs and two digital outputs) can
also be active.

Use the I/ O Descriptions tab (see Figure 9-16) in the Alarm Control Unit Properties
screen to identify external equipment that is connected to the repeater's inputs and out-
puts.

External equipment could be a security light, or any other site equipment.

NOTE: For information about connecting inputs and outputs to a repeater, see chapter 8,
Connecting External Alarms.

To add I/O descriptions for the Alarm Control Unit, use the following procedure.

1. Select Configuration-> Alarm Control Unit.

The ACU Properties screen opens (see Figure 9-16). The I/O Descriptions tab is
active.

2. Provide I/O Descriptions in the screen's date fields.
Enter names for any or all of the following types of repeater inputs and outputs:
*Two different relay outputs
*Two different digital outputs
*One DC input
*Two different digital inputs
3. Click the Apply or OK button.

*The Apply button adds the repeater input or output and keeps the ACU Properties
screen open.

*The OK button adds the repeater input or output and closes the ACU Properties
screen.
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Figure 9-16 ~ ACU Properties Screen, 1/O Descriptions Tab

Alarm Control Unit Properties

1#0 Descriptions | 1/0 Eontrolsl Alarmsl Ext. DC Valtage |

Enter the descriptions for the device's inputs and outputs,

Output

Relay 1: Ioun 1 Digital Idoutx
Relay 2: Ioun [ Digital Idouty

Input

oC Iout21 Digital 1: Idoutw
Digital 2 Idoutz

Ok, I Cancel | Apply

RT131116
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9.12.2 ACU I/O Controls Tab

The I/O Controls tab (see Figure 9-17) turns the 2 relay outputs and digital outputs On or
Off.

1. Toggle the appropriate output either On or Off.
2. Click the Apply or Ok button.

*The Apply button turns the selected outputs either On or Off, and keeps the ACU
Properties screen open.

*The OK button turns the selected outputs either On or Off, and closes the ACU
Properties screen.

Figure 9-17  ACU Properties Screen, I/O Controls Tab

Alarm Control Unit Properties

1/0 Drescriptions |,-' l Alarms] Ext. DC Valtage ]

Relay Outputs Digital Outputs
1 2 1 2
outl4 outls douts douty

1] | Catrcel Apply

RT131117
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9.12.3 ACU Alarms Setting Tab
The Alarms tab (see Figure 9-18) redefines alarm severity for ACU subsystems.
1. Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:
*Disabled
*Event
* Minor
* Major

¢ Critical

NOTE: Alarm settings for External Input 1 and External Input 2 are initially set to Dis-
abled.

2. Click the Apply or OK button.

*The Apply button changes the alarm severity and keeps the ACU Properties screen
open.

*The OK button changes the alarm severity and closes the ACU Properties screen.
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You can set the following types of alarms:

External Input Alarms (1 and 2) - An alarm generated from optional, external equip-
ment.

Temperature Alarm - The temperature threshold of the repeater system has been
exceeded.

Tamp Alarm - The repeater door is open.

Analog Input Alarm - The upper or lower voltage limits have been exceeded from
the DC voltage source for the analog input.

External Growth Alarm - The physical growth box connection to the primary box is
detached.

Growth Temperature Alarm - The temperature threshold of the growth box system
has been exceeded.

Growth Tamper Alarm - The growth box door is open.

Fiqure 9-18  ACU Properties Screen, Alarms Tab

Alarm Control Unit Properties

10 Descriptinns] [0 Controls Alarms ] Ext. DC Voltage]

Alarmn Description | Sewverity i
Eut. Input 1 Alarm Properties Minor b4
Eut. Input 2 Alarm Propertiez Minor -
Ext. DC Woltage Alarm Properties Ewvent -
Primary Tamper Alarm Properties Miror -
Ext. Tamper Alarm Froperties Ewent hd
Growth Communication Alarm Properties bd ajar -
Growth Tamper Alarm Properties Mirar -

0k | Cancel Apply
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550-3100-01 Rev A 9-27



Configure the Repeater RC1920C Repeater Reference Manual

9.12.4 ACU DC Voltage Alarm Threshold Tab

RepeaterNet can monitor an external DC voltage power source (a battery) in a range of 0
to 60 volts, in 250 mV increments. In addition to monitoring the voltage level, you can
define upper and lower limits for the voltage. Exceeding these limits, activates the DC
voltage alarm in the ACU subsystem.

Use the Ext. DC Voltage tab to monitor the voltage of a user-supplied DC power source,
used to power external site equipment. An alarm triggers if the voltage fluctuates, out-
side of a defined operating range.

To define an operating range for DC voltage:

1. Select Configuration -> Alarm Control Unit.
The ACU Properties screen opens.
2. Click the Ext. DC Voltage tab (see Figure 9-19).

3. Define (type in or arrow-click) the normal operating range for the DC power source,
in the Less Than and Greater Than data fields.

4. Click the Apply or OK button.

* The Apply button turns the selected outputs either On or Off and keeps the ACU
Properties screen open.

* The OK button turns the selected outputs either On or Off and closes the ACU
Properties screen.

Fiqure 9-19  ACU Properties Screen, External DC Voltage Tab

Alarm Control Unit Properties

Define the minimum and maximum values that tigger the Esxternal DC
Woltage Alarm.

DC Valtage
Less 1'3 __JII
Greater 1'3 _.JII

] | Cancel

RT131119
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9.13 Modem Properties

From the menu bar in the Main Control Screen, select Configuration -> Modem.
The Modem Properties screen opens (see Figure 9-20). This screen has three tabs:

Alarm Setting Tab - Sets the alarm severity for the Modem alarm. This alarm indicates a
failure of the internal modem.

Modem Properties Tab - Defines the port settings for the internal or external modem.

Pager Setting Tab - Configures a pager, which is notified when an alarm (of a specified
severity level) occurs.

Figure 9-20  Modem Properties Screen

Modem Properties

Alarms Setting ] fodem F'loperties] Pager Setting]

Alarmn Description | Severity |
Modenn Alarm Firor -

QK | Cancel Apply
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9.13.1 Alarm Setting Tab

Use the Alarms tab to redefine alarm severity for the repeater's modem (see Figure 9-21).
Internal modem component failure triggers a Modem alarm.

1. Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:
*Disabled
*Event
* Minor
* Major
*Critical
2. Click the Apply or OK button.

*The Apply button changes the alarm severity and keeps the Modem Properties
screen open.

*The OK button changes the alarm severity and closes the Modem Properties screen.

Figure 9-21 ~ Modem Properties Screen, Alarms Tab

Modem Properties

Alarms Setting ] fodem F'loperties] Pager Setting]

Alarmn Description | Severity |
Modem Summary Alarm Properties inar -

Ok | Cancel Apply

RT131121
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9.13.2 Modem Properties Tab

To define modem settings for the repeater's modem, use the Modem Properties tab (see
Figure 9-22).

NOTE: The RepeaterNet Craft software uses the values for Setup String, Phone Number,
and Call Attempts, only if you are using the RepeaterNet Network Management System,
or other network management software. If you do not have NMS, skip to Section 9.13.3,
“Pager Setting Tab” on page 9-34.

To define modem properties, use the following procedure:

1. Select Modem from the Configuration menu in the Main Control Screen.
The Modem Properties screen opens (see Figure 9-22).
2. Click the Modem Properties tab.
If you are using RepeaterNet NMS, or another network management system, define
the Setup String, Phone Number and Call Attempts.
*Setup String configures a modem. The modem setup string is S37=6.
*The Phone Number is the phone number of a remote computer that the repeater
calls.
*Call Attempts is the number of callouts to attempt before disconnecting; a value of
zero(0) disables calling.
3. Set the Baud Rate for the modem.
The Baud Rate is the communication speed between the modem and the cell phone.
This speed must be greater than 2400. The modem automatically adjusts the Baud
Rate downward, when necessary.
4. Set the Parity to None.
5. Set Data Bits to 8.
NOTE: Set the Parity and Data Bits the same on both the repeater's and computer's
modem.
6. Set the Dial Type to Tone.
7. Click the Apply or OK button.

*The Apply button sets the modem properties and keeps the Modem Properties
screen open.

*The OK button sets the modem properties and closes the Modem Properties screen.
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Fiqure 9-22 Modem Properties Screen, Modem Properties Tab

Modem Properties

&larms Setting  Modem Properties l Fager Setting]

Setup String: |83?=E

Phore Munber: |I-4DB-555-EIDB?

Call Attempts: 3
Baud Rate: 192K -

Parity: MHare -
D ata Bitz Dial Type
7 & Tone
& 3 " Pulze

ak. | Cancel
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Setting Up a Modem for Over-the-Air Repeaters

If you connected an external wireless interface (such as the Telular) to an OA (Over-the-
Air) repeater from Repeater Technologies, Inc. (RTI), then you must properly configure
the repeater's modem. If you improperly set up the modem, calls to the OA repeater will
not be successful.

Use the following procedure to set up the modem for all Repeater Technologies OA prod-
ucts.

Connect to the repeater through the local Craft port.

Start RepeaterNet software.

Establish a connection to the repeater.

Select Configuration from the menu bar located at the top of the screen.
From the Configuration menu, select Modem Properties.

Click on the Modem Properties tab.

Enter S37=6 in the Setup String field (the top field on the Modem tab).

Enter a Phone Number.

® NG

For example, enter:
9,222 123-4567

NOTE: Each comma creates a two-second delay in dialing. The RepeaterNet software
ignores parentheses () and spaces.
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9. Enter the number times that RepeaterNet should attempt to make the connection.

For example, enter:
3

NOTE: Entering zero(0) in this field disables calling.

10. Click Apply or OK button at the bottom of the window.

*The Apply button sets the modem properties and keeps the Modem Properties
screen open.

*The OK button sets the modem properties and closes the Modem Properties screen.

Important Points About Modem Setup

* This procedure forces the repeater initialize the modem to 2400 baud, which
improves the connection on analog wireless networks.

If you configure a repeater to automatically call out and report alarm status, the
repeater Com port settings must match the settings of the modem that the repeater
calls.

If you use a modem to login to the repeater, the port settings of the computer's
modem (defined in the configuration file) must match the settings of the repeater
modem.

If the repeater is equipped with an internal modem, the repeater's hardware auto-
matically controls the setup string. However, if the repeater is connected to an exter-
nal modem, you must consult the modem's documentation for the setup string.

Changes to the default settings on the Modem Properties screen, take effect when
you exit the RepeaterNet software.
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9.13.3 Pager Setting Tab

The Pager Setting tab sets the RepeaterNet software, so that it sends out a page when an
alarm occurs. It also assigns a specified severity level to the alarm. Table 9-3 describes the

Alarm Severity settings.

RepeaterNet generates a page if the summary alarm severity is greater than or equal to
the selected Minimum Severity setting. When RepeaterNet detects a page request, the
repeater terminates any current modem connection, and generates a page. The page for-
mat consists of the repeater number, followed by the severity level. For example:

123456-2

where 123456 is the repeater number, and 2 is the severity level of the alarm.

If RepeaterNet detects a change in the current alarm severity, it does the following:

* If you set the Minimum Severity to Major, the RepeaterNet software generates a page

with a severity of 2.

* If the RepeaterNet software detects a Critical alarm, it generates a new page with a

severity of 3.

* If you clear the Major alarm, but the Critical alarm remains, the RepeaterNet soft-
ware generates a new page with a severity level of 1, indicating that the Critical

alarm remains.

* If you then clear the Critical alarm, the RepeaterNet software generates a page with a

severity of 0.

* If the RepeaterNet software detects a Minor or Event alarm, it does not generate a

page.

Table 9-3 Alarm Severity Numbers

Alarm Type

Severity Number

No Alarms

Critical Alarm

Major Alarm

Critical + Major

Minor Alarm

Critical + Minor

Major + Minor

Critical + Major + Minor

N| | O] | Q| N| R O
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Use the following procedure to set a pager.

1. Click on the Pager Setting tab of the Modem Properties screen.
2. Enter the Pager Number.

The Pager Number is the phone number to call. This phone number must include the
networking access number (9), 1 and the area code (if needed). Access the network
dial number, and wait five seconds before sending the page sequence.

Several commas must follow the phone number. Each comma generates a delay of one
second. Generally, a pager company requires about three seconds to pick up the line, and
allows a maximum of five seconds before they drop the connection.

Therefore, a good delay setting is five seconds - that is, add five commas. For example:

91 408 555-1212,,,,,

NOTE: RepeaterNet ignores any characters used for clarity, such as spaces, dashes, and
parentheses.

3. Enter the number of times RepeaterNet should attempt to call the pager number
(Call Attempts).

NOTE: A value of zero(0) in this field disables paging.

4. Enter the number of the repeater (Repeater Number).
This is a system identification number or description.
5. Select one of the following minimum alarm severity settings for paging:
*Critical
* Major
* Minor
6. Click the Apply or OK button.

*The Apply button sets the pager properties and keeps the Pager Properties screen
open.

*The OK button sets the pager properties and closes the Pager Properties screen.
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9.14 Cell Phone Properties

1. From the Configuration menu in the Main Control screen, select Cellular Phone.

The Cell Phone Properties screen opens (see Figure 9-23).

NOTE: If the repeater does not have a cell phone, the Cellular Phone Properties selection
is disabled.

2. Use the Alarm Setting tab to set the alarm severity for the Cellular Alarm.
The Cell Phone alarm indicated a failure of a cellular phone.

3. Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:

*Disabled
*Event
*Minor
* Major

¢ Critical

NOTE: The cellular phone alarm severity should normally be set to minor. The Cell
Phone alarm generates if the cell phone fails to report an alarm, after all retry attempts by

either the modem or the pager. This alarm clears when the cell phone succeeds in report-
ing an alarm.

4. Click the Apply or OK button.

*The Apply button changes the alarm severity setting and keeps the Cellular Phone
Properties screen open.

*The OK button changes the alarm severity setting and closes the Cellular Phone
Properties screen.
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Fiqure 9-23  Cellular Phone Properties Screen

Modem Properties

Alarms Setting ] fodem Prnperties] Pager Setting]

Alarmn Description | Severity |
Cell Phone Summary Alarm Properties inar -

’Tl Cancel Apply

RT131123
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9.15 Power System Properties

1. From the Configuration menu in the Main Control screen, select Power System.

The Power System Properties screen opens (see Figure 9-24). This screen provides
access to initial configuration settings for the power subsystem.

2. Use the Alarm Setting tab to redefine alarm severity for the power systems.

The Alarm Setting tab sets the alarm severity for the following alarms:
Input Power Alarm - The input power to the repeater is out of the system tolerances.
Power Supply Alarm - The internal system power of the repeater is out of tolerances.

DS Battery Alarm - The voltage of the internal battery is below tolerances. This battery
supplies power to the Alarm Control Unit (ACU), modem, and cell phone, in the event of
a system power failure. This internal battery lets the repeater call out and report its status.
It also supplied power to the memory that stores the Alarm and Event Log.

NOTE: The internal battery does not provide power for RF components. The repeater
cannot provide RF coverage during a power failure.

Growth Box Input Power Alarm - The input power to the growth box is out of system tol-
erances.

Growth Box Power Supply Alarm - The internal system power of the growth box is out of
tolerances.

3. Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:

*Disabled
*Event
*Minor
* Major

¢ Critical
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4. Click the Apply or OK button.

*The Apply button changes the alarm severity setting and keeps the Power System
Properties screen open.

*The OK button changes the alarm severity setting and closes the Power System
Properties screen.

Figure 9-24  Power System Properties Screen

Power System Properties

Alarmsz Setting l

&larm Descriphion ] Severity |
Primary Input Power élarm Properties Dizabled
Battery &larm Froperties Dizabled

Primary Power Supply Summary Slarm Properties Dizabled
Growth Power Supply Summary Alarm Properties Dizabled
Growth Input Power Alarm Properties Dizabled

4 4 4 44

0Ok, | Cancel Help

RT131124
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9.16 Back-up Power System (UPS) Properties

The UPS Properties screen provides the initial configuration settings for the optional
Back-up Power Supply (BUPS), which is external to the repeater.

1. From the menu bar in the Main Control screen, select Configuration -> UPS.
The UPS Properties screen opens (see Figure 9-25).
2. Use the Alarm Setting tab to redefine alarm severity for the back-up power systems.

The Alarm Setting tab sets the alarm severity for the following alarms:

AC Fail Alarm - Indicates that the input power to the BUPS has failed. Depending on
which BUPS model is installed at the repeater site, the BUPS will then provide 40 or 80
amp-hours of backup power for the repeater, before shutdown. The AC source powers
the charger.

Low Battery Alarm - Indicates that battery voltage for the BUPS is below operating toler-
ances, and the BUPS cannot power the repeater.

High Battery Alarm - Indicates that the battery voltage of the BUPS is above operating
tolerances, and the BUPS cannot power the repeater.

Charger Fail Alarm - Indicates that the internal charger of the BUPS has failed, and the
BUPS is unable to recharge its batteries.

UPS Summary Alarm - Indicates that one or more of the BUPS alarms have triggered.
UPS Tamper Alarm - Indicates that the door of the BUPS is open.

3. Click the down-arrow next to an Alarm field to select one of the following alarm
severity settings:

*Disabled
*Event
*Minor
* Major

¢ Critical

9-40 550-3100-01 Rev A



RC1920C Repeater Reference Manual

Configure the Repeater

4. Click the Apply or OK button.

*The Apply button changes the alarm severity setting and keeps the UPS Properties

screen open.

*The OK button changes the alarm severity setting and closes the UPS Properties

screen.

Figure 9-25 ~ UPS Properties Screen

UPS
Alarms Setting ]
Alarm Degcription J Senverity |
BUPS Tamper Alarm Properties M ajor -
BUPS AC Fail Alarm Properties Iiror -
BUPS Battery Low Alarm Properties imor -
BUPS Battery High Alarm Froperties Mirar -
BUPS Charger Fail Alarm Properties inor -
BUPS Surmary Alarm Properties kimor -
ok | Cancel Help
RT131125
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9.17 Monitoring Repeater Status

The subsystem Status screens monitor and control various repeater system functions. By
clicking the appropriate subsystem icons, you can check each subsystem in the repeater.

Each Status screen includes one or more of the following tabs:
Alarms Tab - Reports present subsystem alarm states, with date and time stamps.

Measurements Tab - Reports power and operational temperature measurements, includ-
ing Low and High values. A Reset Low/High button resets the values.

Voltages Tab - Reports present voltages for a subsystem.
Control Tab - Includes On/Off switches for internal and external subsystem hardware.
Status screens for the repeater are:

* Front End Status

* Channel Status

* Filter Status (Forward and Reverse)
* PA Status (Forward and Reverse)

* Alarm Control Unit (ACU) Status

* Modem Status

* Cellular Phone Status

* Power System Status

* UPS Status
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9.18 Front End Status

Click an FFE (Forward Front End) icon to display the Front End Status screen.
The Alarm tab in the Front End Status screen reports theses alarms:

Forward FE Alarm - This alarm activates when the forward signal power level is too
strong, and is being attenuated to protect the repeater from possible damage (see
Figure 9-26).

Figure 9-26  Forward Front End Status Screen

Forward Front End Status
Alarm ]
Description | Statuz | Date J Tirme: i
FuwdFE Summary dlarm Dizabled 20004012 174833

Ok | Caticel

RT131126
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Reverse FE Alarm - This alarm activates when the reverse signal power level is too
strong, and is being attenuated to protect the repeater from possible damages (see
Figure 9-27).

Figure 9-27  Reverse Front End Status Screen

Reverse Front End Status |
Alarm ]
Deszcription Date Time 1
RewFE Summary &larm 2000-mM-12 17:48:33
RevFE Overoad Alarm 2000-01-12 17:48:33

0K | Cancel

RT131127
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Diversity FE Alarm - This alarm activates when the Diversity Receive signal power level
is too strong, and is being attenuated to protect the repeater from possible damage (see
Figure 9-28).

Figure 9-28  Diversity Front End Status Screen

Diversity Front End Status E|
Alarm l
Description | Statug I Date J Time 1
DivFE Suramary Alarm P ElEa  2000-01-12 17:48:33

oK | Cancel

RT131128
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9.19 Channel Filter Status

Click a Channel 1 or Channel 2 filter icon (sine waves) to open a filter Status screen.

The Channel Filter Status screen (see Figure 9-29) reports a CSF1 Forward Alarm (For-
ward Filter), and a CSF1 Reverse Alarm (Reverse Filter), both including date and time
stamps.

A failure in the Reverse or Forward filter assembly triggers an alarm.

Fiqure 9-29  Channel Filter Status Screen

Channel 1 Forward Filter Status
Alarm ]
Description | Status J Date J Tirme: i
FundCEFT Summary Alarm | | 2000412 174833
FwdCSF1 Lock Alam 200040112 17:48:33

ak | Cancel

RT131129
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9.20 Channel PA Status

Click a Channel 1 or Channel 2 FPA (Forward Power Amplifier) or a RPA (Reverse Power
Amplifier) icon, to open a PA Status screen.

9.20.1 PA Alarm Tab

The PA Alarm tab (see Figure 9-30) reports subsystem alarms, including date and time
stamps. A failure in the Forward or Reverse PA assembly triggers an alarm.

Figure 9-30

Power Amplifier Status Screen, Alarms Tab

Channel 1 Forward PA Status

Alarm ] Measuiement |

D escription | Status ] Date | Tirne

FuwdPA1 Temp Alarm i B 2000-01-12 174833
FrudPAT Summary Alarm 2000-01-12 17:48:33
FudPA] aLC Alarm 20004012 17:48:33

] 4 | Cahcel

RT131130
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9.20.2 PA Measurement Tab

The Channel 1 and Channel 2 PA Measurement tabs (see Figure 9-31) report the output
power of the repeater, including low and high output values.

To reset low and high output values, click Reset Low/High.

Fiqure 9-31  Power Amplifier Status Screen, Measurement Tab

Channel 1 Forward PA Status

Alarn Measurement ]

Measurement Description | Current ] Low | High I
FwdPa1 Current 0.0 0 0o Fioset Low/High ]
FwdPa1 Reflected Power 0.0 0o 0o g
FudPA1 FredPower 0.0 0o oo
FuwdF&1 Temp 0.0 0o oo

] 4 | Cancel Help

RT131131
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9.21 ACU Status

Click the ACU icon to open the ACU Status screen.
This screen has two tabs:

e Alarm

¢ Measurement

ACU Alarm Tab

The Alarm tab (see Figure 9-32) reports subsystem alarms, including date and time
stamps. A failure in the ACU assembly triggers an alarm. ACU alarms include:

External Input Alarms (1 and 2) - The alarm is from a piece of optional, external equip-

ment.
Temperature Alarm - The system temperature threshold was exceeded.
Tamper Alarm - The repeater door is open.

Analog Input Alarm - The upper and lower voltage limit was exceeded, from the DC
voltage source for the analog input.

External Growth Box Alarm Status - The growth box connection (to the primary repeater
box) is detached, disconnected, or broken.

Fiqure 9-32  ACU Status Screen, Alarm Tab

ACU Status
Alarm ] Measurement ]

Description 1 Status Date ] Time

Ext Input 1 Alam | 2000-001-12 17:48:33
Eut Input 2 Alarm 2000-01-12 17:48:33
Ext DC YWoltage Alarm 2000-01-12 17:48:33
Frirary T amper Alarmm 20000112 17:48:33
Ext. Tamper Alarm 2000-00-12 17:48:33
Growth Communication Alarm 2000-01-12 17:48:33
Growth T amper &lam 20000112 17:48:33

Ok | Cancel
RT131132
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9.21.1 ACU Status Screen, Measurement Tab

The Measurement tab (see Figure 9-33) reports current, low, and high system tempera-
ture.

It also reports DC voltage source values.

Click on the Reset Low/High button to reset the low and high values.

Figure 9-33 ~ ACU Status Screen, Measurement Tab

ACU Status |

Alarm  Meazurement l

Measurement Description | Current ] Low High I

Frirmary Temp 0.0 0o 0.0 ;
Ext. DC Yoltage 0o oo 0o Feset Low/High

0K | Cancel Help

RT131133
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9.22 Modem Status

Click on the Modem icon.

The Modem Status screen opens (seeFigure 9-34). This screen reports a modem alarm,
including a date and time stamp.

Failure of an internal modem component triggers a Modem alarm.

Figure 9-34  Modem Status Screen

Modem Status |
Alarm ]
Description | Status I Date Time 1
Modemn Surmmary &larm B Elean 20000112 17:48:33

oK | Cancel

RT131134
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9.23 Cell Phone Status

Click on the Cell Phone icon.

The Cell Phone Status screen (see Figure 9-35) opens. This screen reports any Cell Phone
Alarm, including a date and time stamp.

Failure of an internal cellular phone component triggers a Cell Phone alarm.

Figure 9-35  Cell Phone Status Screen

Cellular Phone Status
Alarm ]
Description | Status | Date J Tirre 1
CellPhone Summary &larm D CESEY 20000112 17:48:33
Ok | Cancel
RT131135
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9.24 Power System Status
Click the Power icon.

The Power System Status screen opens. This screen monitors and operates the repeater's
power subsystem.

9.24.1 Alarm Tab

The Alarm tab (see Figure 9-36) reports the status of the following alarms, including
severity, date and time information for each:

Input Power Alarm - The input power to the repeater is out of tolerance.
Power Supply Alarm - The system power for the repeater is out of tolerance.

PS Battery Alarm - Indicates that the voltage of the internal battery is out of tolerance.
This battery supplies power to the ACU, modem, and cellular phone, in the event of a
system power failure. The repeater uses this battery to call out and report its status. The
battery also supplies power to the memory, which stores that Alarm and Event Log.

The internal battery does not provide power for RF components. The repeater cannot
provide RF coverage during a power failure.

Figure 9-36  Power System Status Screen, Alarms Tab

Power System Status
Alarm ] Voltages ]
Description Date J Time ]
Frimary [nput Power Alarm 2000-0-12 17.48:33
Battery Alarm 2000-mM-142 17:48:33
Frimary Fawer Supply Summary .. 2000-01-12 17:48:33
Grovith Power Supply Surammary . 2000-01-12 17:48:33
Growth [nput Power Alarm 2000-0112 17.48:33
0K | Cancel
RT131136
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9.24.2 Voltages Tab

The Voltages tab (see Figure 9-37) shows the current power values for:

*Battery Volts
*Channel 1 PA (Power Amplifier) Volts
*Channel 2 PA Volts

Figure 9-37  Power System Status Screen, Voltages Tab

Power Spstem Status
Alarm Voltages ]
Description oltage
Batter oo
Prirnary %24 oo
Prirnary %10 0o
Primary “¥CC1 oo
Primary YCC2 oo
Growth W24 0o
Growth W10 0o
Growth WCC1 an
Growth WCC2 nn

6] | Cancel Help

RT131137
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9.25 UPS Status

The UPS Status (Uninterruptable Power Supply status) screen monitors the optional,
external Back-up Power Supply (BUPS).

The Alarms tab in this screen (see Figure 9-38) displays the alarm status of the following
alarms:

AC Fail Alarm - Input power to the BUPS failed. The BUPS provides 40 or 80 amp-hours
of backup power (depending on the installed BUPS type) at the repeater site, before shut-
down. The AC source powers the charger.

Low Battery Alarm - BUPS battery voltage is below operating tolerances, and cannot
power any repeater functions.

High Battery Alarm - BUPS battery voltage is above operating tolerances, and cannot
power any repeater functions.

Charger Fail Alarm - The internal charger for the BUPS has failed. The BUPS cannot
recharge its batteries.

UPS Summary Alarm - One or more of the BUPS alarms has triggered.
UPS Tamper Alarm - The door of the BUPS is open.

Figure 9-38  UPS Status Screen, Alarms Tab

UPS Status
Alarm l
Description Status Date j Tirne 1
BUPS Tamper Alarm | l Jan 01,1570 12:00:00 Ak
BUPS AC Fail Alarm Jan 01, 1970 12:00:00 A
BUPS Battery Low Alarm Jan01,1970 12:00:00 Ak
BUPS Battery High Alarm Jan 01,1570 12:00:00 Lbd
BLUPS Charger Fail Alarm Jan 01, 1970 12:00:00 A
BUPS Summary Alarm Jan 01, 1370 12:00:00 Abd
0K | Cancel
RT131138
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9.26 RepeaterNet Menu Commands

This section describes commands that you can run from the menu bar, in the RepeaterNet
Main Control screen.

9.26.1 File Menu - RepeaterNet Craft

From the Main Control screen, open the File menu. Figure 9-39 shows the RepeaterNet
commands in this menu.

Fiqure 9-39  RepeaterNet Craft, File Menu

Download Properties
Upload Properties

|Update Repeater Firmware

Exit

RT131139

Download Properties

Use the Download Properties command to download all settings that are already
uploaded to a repeater, including;:

* Download the default configuration file, which is distributed with the Craft soft-
ware. Downloading avoids manually configuring each setting.

* Restore repeater configuration settings. Restoring overwrites existing configuration
settings. Use this option if you previously used the Upload Properties command to
store repeater configuration settings.

Figure 9-40 shows the preset configuration files that distributed with RepeaterNet Craft
installation software. To find these files, follow the Windows Explorer path shown.
Table 9-4 describes each of these files.

NOTE: Examples shown are for the OA850C repeater.
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Fiqure 9-40  Preset Configuration Files in RepeaterNet Craft

#] Desktop
-2 My Computer
#-d 3% Floppy (A) Name Size | Type
== Repeater (C) AOA1900C 1 Chan ModemPhonePagerrcl.  8KB RCF File
-1 Program Files [#] OAT900C_1_Chan_NMS rct 8KB RCF File
- =] 0A1900C_2_Chan_ModemPhonePager.rcf 13KB RCF File
i :: 23‘;’;595""“ [a]OA1800C_2_Chan_NMS.rcf 13KB RCF File
R (=] OAB00_1_Chan_ModemPhonePager.rcf 8kB RCF File
<] Real (=] OAB00_1_Chan_NMS rcf 8KB RCF File
--_] Repeater Technologies (=] OAB00_2_Chan_ModemPhonePager.rcf 8KB RCF File
- (1 RepeaterNet Craft 2.2 [#] 0A800_2_Chan_NMS rcf BKB RCF File
1 Backup =] 0A850C_1_Chan_ModemPhoneFager.rct 12KB RCF File
1 Bitmaps =] 0ASS0C_1_Chan_NMS.rcf 12KB RCF File
=] 0ABS0C_2_Chan_ModemPhoneFager.rcf 12KB RCF File
— Cache 2] 0A850C_2_Chan_NMS.rcf 12KB RCF File
—" =] DABS0C_2_ ChaMNMS. rct 12KB RCF File
1 Firmware Files |
RT131140

Table 9-4 Descriptions of Configuration Files

Configuration File Configuration

OA850C_2_Chan_NMS.rcf 2-channel OC850C repeater without modem or phone

OA850C_2_Chan_ModemPhonePager.rcf | 2-channel OA850C repeater with modem or phone

OA850C_1_Chan_ModemPhonePager.rcf | 1-channel OA850C repeater with modem or phone

OA850C_1_Chan_NMS.rcf 1-channel OA850C repeater without modem or phone

Use the following procedure to download settings to a repeater, from the standard
repeater configuration file.

1. From the Craft Main Control File menu, select Download Properties.

A confirmation box lets you either confirm, or cancel, the downloading.
2. Click on the OK button to proceed.

A Select File to Restore box displays (see Figure 9-41).
3. Select the repeater configuration file whose properties will be download.
4. Click on the Open button to proceed with the download.

When the download is complete, a confirmation message box displays.
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Fiqure 9-41  Downloading Repeater Confiquration Files

Look in; |ﬁ Configuration Files :_-_j _J J F—'_‘i

|#] AB50C_1_Chan_ModemPhoneNMS rct =] OAT900
ﬂABEﬂC_Z_Chan_NMS_rCf £0A19|]|]
|#] event.rcf =] OAB00_
=] grathall.rct =] 0AB00_
{#] greathall.rct =] OABOD_
=] nanthoc.rcf =] OAB00_
4| »
File name: Open i

Files af type: iHepeater Configuration Files [%.rcf] m:j Cancel 1

[ Open as iead-only

RT131141

Upload Properties

RepeaterNet stores system settings in a repeater configuration (.rcf) file. You can upload
all settings from one repeater, and download these settings to additional repeaters in a
network. You also can use existing configuration files to configure a replacement unit.

To upload the configuration from repeater, use the Upload Properties command. You can
then use the Download Properties command, to copy the configuration to individual
repeaters in the CDMA network.

Use the following procedure to upload system settings, and to create repeater configura-
tion files.

1.

IS

Select a repeater.

Open the Craft software.

Select File -> Upload Properties.

A Select File to Save Repeater Properties To dialog box opens (see Figure 9-42).

Enter a name for the file, without a file extension.

RepeaterNet Craft automatically adds a .rcf extension to the file name; for example:
Filename.rcf

Click Save to initiate the upload.

When the upload is complete, a message box displays.

Click the OK button.

Save a copy of the repeater configuration file onto a floppy disk, for safe keeping.
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NOTE: When creating a backup file, be aware that if you used a Network Monitor login
to create Repeater Configuration (.rcf) files, then the files include Ids and passwords.
The Craft software saves the Repeater Configuration (.rcf) in the RepeaterNet program

directory.

Figure 9-42  Saving Repeater Properties to a File

Select a file to save repeater properties to

Save in: | =3 Configuration Files

-] ;n:ij B

2[x]

[#] ABBOC_2_Chan_NMS.rci
[#] event.rct

=] grathall.rcf

=] greathall.rct

[#] nanthoc.rcf

ol |

|2] ABS0C_1_Chan_ModemPhoneNMS.rcf

= 0A1900
=] 0A1900
[#] OAB00_
=] 0AB00_
=] 0ABDD_
=] 0ABDD_

File narne: ﬁ

Save az bype: iHepeater Config Files [*.rzf]

™ Open as tead-only

Save

2
[ gae |
Caricel I

Update Repeater Firmware

RT131142

Use the Update Repeater Firmware command to install a firmware upgrade.

NOTE: Repeater Technologies, Inc. (RTI) automatically sends firmware updates to the
designated point of contact, for every affected owner of a specific type of repeater. RTI

uses overnight delivery to send update packages.

Firmware updates include:

* A detailed description of the update

* A floppy disk containing the firmware update

¢ Installation instructions

Direct any questions concerning the firmware upgrade to the Repeater Technologies Cus-

tomer Service Department.

550-3100-01 Rev A
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To install a firmware upgrade:

1. Read the documentation provided with the firmware upgrade.
Login to a communications session, using the repeater to be upgraded.

Insert the upgrade disk into the computer's floppy drive.

L

From the menu bar in the Main Control screen, select File -> Update Repeater Firm-
ware.

A message box displays (see Figure 9-43).
5. Click on the OK button.

A file selection screen displays (see Figure 9-44).

Figure 9-43  Firmware Update Message Box

RepeaterMet

Downloading firrmware will require a warm restart.
Please confirm: Download firmware to the repeater?

Cancel |

RT131143

Figure 9-44  Selecting File Names for Saving Firmware Updates

Select a file to save repeater properties to .
Save jn: | =5 Configuration Files ;j gj E =

#| AB50C_1_Chan_ModemPhoneNMS rct =] OA1900
ﬂABEI]C_Z_Chan_NMS.rCf ﬁlOA1 900
=] event.rcf [=] OABDO_
#] grathall_rct =] OAB00_
#| greathall.rc [#] OABOD_
=] nanthoc.rct =] 0ABDO_
<] | 2l
File narme: Fﬁ; Save I
Save as type: ]Hepeater Configuration Files [#.rcf] ‘_:__j Cancel i

[T Open as read-only

RT131144
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6. Select whether to save the repeater's configuration.

*To save the configuration and continue updating firmware, select an .rcf file, and
click the Save button.

*To cancel saving the repeater configuration to a file, click the Cancel button.

Either way, the upload operation proceeds. An Uploading Repeater window dis-
plays the progress of the upload.

When the upload completes, the Select a Firmware File to Download to the Repeater
box displays (see Figure 9-45).
In the Look In field, select the disk drive that contains the upload disk.
8. Double-click the upgrade file.
The upgrade file is labeled with an .s09 extension - for example:
Filename.s09
Installation overwrites the previous firmware version.

When the upgrade is complete, the Craft software automatically restores the
repeater's configuration, from the file selected in the Open dialog box.

Figure 9-45  File Selection Box for Downloading Firmware

Select a firmware file to download to the repeater EHE

Look jm: ;’ﬂ Firmeare files :_! _ﬁf;} [::EW

Filez of type: !Firmwarefiles[".sﬂg] _'_.! Cancel |

™ Open as read-only

RT131145

Exit

The Exit command ends an active session in the RepeaterNet software, and returns to the
Welcome screen.
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9.26.2 Configuration Menu - RepeaterNet Craft

To initially configure the repeater, use the Configuration menu commands, shown in
Figure 9-46.

See Section 9.8, “Configuring Repeater Properties” on page 9-11, for detailed information.

Fiqure 9-46  RepeaterNet Craft, Configuration Menu

Front End
Channel 1

Alarm Control Uit
kaodem/Pager
Cell/PCS Phone
Power System
EUPS

Hardware Setting
RT131146
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9.26.3 System Menu - RepeaterNet Craft

This section describes commands in the System menu, as shown in Figure 9-47.

Fiqure 9-47  RepeaterNet Craft, System Menu

Froperties...
Alarm and Event Log L

Befresh Alarms

Test Alarm Dial Out Setup
RT131147

Properties
Select Properties from the System menu.

The System Properties screen opens.

NOTE: When the repeater is on a network, you must enter the system name, as used at
the Network Management Station. This ensures that RepeaterNet Craft recognizes unso-
licited alarms.
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System Tab

The System tab includes data fields for storing site-specific information (see Figure 9-48):

* The system name (name of the repeater)
* Brief site information (such as network name, or a city location)

* The repeater phone number, if the repeater has a modem option

Entering summary data (on the System tab) is optional, but RTI recommends entering
this data.

To record system data:

1.

Type the required information in each data field:
*System (Repeater) Name - up to 12 characters (required)

*During automatic reporting, the repeater name displays in the title bar of the Main
Control screen, identifying the selected repeater.

*Site Information, Field 1 - up to 14 characters. Typically, identifies the cell phone
network (optional)

*Site Information, Field 2 - up to 14 characters. Typically, identifies the repeater loca-
tion (optional).

*Site Phone Number - phone number of the repeater, up to 12 characters (optional)

Click the Apply or OK button.

*The Apply button sets the system properties and keeps the System Properties
screen open.

*The OK button sets the system properties and closes the System Properties screen.

Fiqure 9-48  System Properties Screen, System Tab

System Properties

System l Syztem Inventol_l,l] Syztem Login ]

Swyatern Mame: W
Site Info: [Marts
Site Info2: [Marts
Site Phone Mumber: Im

Ok | Cancel

RT131148
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System Inventory Tab

The System Inventory tab (see Figure 9-49) displays information about the repeater to
which the PC or laptop is connected.

After you successfully login, RepeaterNet reads this information directly from the
repeater.

NOTE: You cannot edit data in any field of this tab.

Table 9-5 summarizes the data displayed in the information-only fields of this tab.

Fiqure 9-49  System Properties Screen, System Inventory Tab

System Properties [ %]

| Sypstem Login I

Azzembly Part Murnber: W
Serial Mumber: |3135—
Date Code: lgggg—
Hardware Yersion: |3—
Boot Code Yersion W
Installed Options: l—
Firrnware Yersior: W

0k, I Cancel Lpply

RT131149
Table 9-5 Description of System Inventory Fields
Field Name Description
Assembly Part Number The part number of the repeater (for example: 090-1200-09)
Serial Number The 9-digit serial number of the repeater
Date Code The date when the repeater was built
Hardware Revision The repeater hardware revision (such as Rev. A)
Boot Code Version The version number of the boot code installed in the repeater.
Installed Options Optional internal equipment in the repeater (such as cell phone)
Firmware Version The version number of the firmware installed in the repeater
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System Login Tab

The System Login tab (see Figure 9-50) includes fields to do the following:
* Type in login IDs
* Type in passwords

* Configure the Auto-logout function

In the Auto-Logout Inactivity Time field, define how long RepeaterNet should wait, dur-
ing a period of inactivity, before it terminates a session.

You can define a separate time interval in minutes, between 1 and 60, for each access
level. If you enter a zero in a time field, this feature becomes disabled.

NOTE: When the repeater is part of a network, the time field must be zero(0).

Figure 9-50  System Properties Screen, System Login Tab

System Properties

Sy$tem| System Inventory  System Login l

Auto-Logout

Login Type Login 1D Fazswiord Inactivity Time
Craft: =1
Cra [BDMIN |CRAFT [15 -
Netwaork, b onitar: Jur|
Metwork, Monitar |D |D |D =

ok, | Cancel Apply

RT131150

To change a login ID or password:

1. Login to the repeater (as an administrator).

Select Properties... from the System menu.

Click the Login tab.

Type the new login ID or password into the appropriate fields.

Ll
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NOTE: The login ID and the password must each consist of six or fewer characters.

Write down the login Ids and passwords, and secure them in a safe place.
6. Click the Apply or OK button to set the new information.

*The Apply button sets the login information and keeps the System Properties
screen open.

*The OK button sets the login information and closes the System Properties screen.

7. Notity affected operators about the ID and password changes.

NOTE: When the repeater is networked, this information also must reside in the NMS
Database.

Alarm and Event [og

Open the Alarm and Event Log from the System menu, to view the alarm and event his-
tory. This log dynamically updates during viewing.

Line entries in the Alarm and Event Log are organized as follows:

1. Subsystem affected by an alarm or event
2. Alarm severity

3. Date and time stamp
You can use Notepad to print or save Alarm and Event Log entries.
9.26.4 Options Menu - RepeaterNet Craft

Figure 9-51 shows the RepeaterNet commands in the Options menu.

Fiqure 9-51  RepeaterNet Craft, Options Menu

Color Independent Icons
Alarm Sounds
v Hold Connection

RT131151
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Color Independent Icons

Color Independent Icons are special graphic indicators, designed to assist operators who
are unable to distinguish colors. As part of the alarm reporting system, Color Indepen-
dent Icons display on the Main Control screen for a Critical, Major, or Minor alarm.

By default, the Color Independent Icons feature is Off.

From the Main Control screen menu bar, select Options -> Color Independent Icons, to
turn On this feature. Table 9-6 describes each of the color-independent icons.

Table 9-6 Description of Color Independent Icons

Alarm Type Color Independent icon Symbol
Critical X through the subsystem icon X
Major Back slash (\) through the subsystem icon. \
Minor Dotted-line back slash through subsystem icon

Alarm Sounds

The Alarm Sounds feature allows an intermittent audible alarm to activate, when a sub-
system triggers an alarm.

By default, the Alarm Sounds feature is Off.

From the Main Control screen menu bar, select Options -> Alarm Sounds, to turn On this
feature.

To silence an audible alarm, either click a subsystem icon (to open the Status screen), or
clear the alarm.

9-68
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9.26.5 Help Menu - RepeaterNet Craft

RepeaterNet on-line help provides quick access to information related to the operation of
the repeater. Figure 9-52 shows the Help menu.

* To open RepeaterNet Help, select Help -> Help Topics.

* To learn about the version of RepeaterNet Craft, RepeaterNet NMS, or RepeaterNet
Administrator installed, select About... from the Help menu of any program win-
dow.

Figure 9-53 shows a typical window that opens when you select Help -> Help Topics.

Figure 9-52  RepeaterNet Craft, Help Menu

Help Topics

About__.

RT131152

Fiqure 9-53  Help Topics Window

Help Topics: 850chelp ?1 X

Contents | index | Find |

Click aboak, and then click Open. Or click another tab, such az Indes.

Open | Frint... Cancel

RT131153
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Contents Tab

1. From the Contents tab (see Figure 9-54) of the Help Topics window, double-click a
book icon.

Online Help opens the book's contents.
2. Double-click a topic icon.

This opens the topic's Help page.

A help page provides detailed topic information. Help pages can contain links to related
topics (green, underlined text identifies a link).

Fiqure 9-54  Help Topics Window, Contents Tab

Help Topics: 850chelp !

Contents | Index | Find |

Click a topic, and then click Display. Or click another tab, such az Index.

Contents

Copyright

RepeaterMet Craft Software

Minirmum Syztem Reguirements

Installation Procedure

Configuring the Repeater Connection

Starting Repeatert et Craft

0A850C MR RepeaterM et Craft #ain Control Screen
Configuration

Statuz Reporting

Alarm Status Beparting on the Main Contral Screen
Drefining Alarm Severity

Configuring 0A850C MR Properties

Front End Properties ...:.j

Cloze ; Frint... ; Cancel ;

RT131154
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Index Tab

1. From the Index tab (see Figure 9-55) of the Help Topics window, do either of the fol-
lowing:
*Type a topic name in the data field.
*Online help automatically jumps to the index entry for the selected topic.
* Use the scroll bar to locate a topic entry.
2. Double-click an index entry.

The appropriate Help page opens.

Figure 9-55  Help Topics Window, Index Tab

Help Topics: 850chelp i

Contents  Index ;Find ;

1 Tuvpe the firgt few letters of the word you're looking for.

2 Click the index entry pou want, and then click Dizplag.

BAcceszing the QK] Cellular Phone -
AL &larm Tab

ACL Alarms Setting Tab

ACL DC Valtage Alarm Threshold Tab

ACL /0 Contrals Tab

ACU /0 Descriptions Tab

AL Measurement Tab

ACL Properties

AL Status

Alarm and Event Log Command

Alarm Setting

Alarm Sounds Command

Alarm Status Reporting on the Main Control Screen
Backup Power Sypstem [UPS) Froperties

Cell Phone Properties

Cell Phone Status
Channel # T ab - i

Dizplay i Frintk... I Cancel i

RT131155
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Find Tab

1. Inthe Help Topics Window, click on the Find tab.
The Find Setup Wizard utility opens (see Figure 9-56).

Use this wizard to search for specific words and phrases in Online Help, instead of
searching by category.

2. Follow the prompts in the Find Setup Wizard utility.
When the Find Setup Wizard finishes, a window such as Figure 9-57 displays.

Fiqure 9-56  Find Setup Wizard (Two Screens)

Find Setup Wizard

Find enables pou to search for specific wordz and
phrases in help topics, instead of zearching for
information by categony.

Before you can use Find, Windows must first create a list
[or databasze), which contains every ward fran your help
filefz].

To create this list now click Mext,

& Mirirmize database size [recommended]

" Mawimize search capabilities

" Custamize search capabilities

| Mest > | Cancel ‘

Find Setup Wizard

Click. Finizh to start creating the word list. This process
may take a while, but you only need to do it once.

Once the list has been created, vou can click the Find
tah to search for specific words and phrazes.

< Back Cancel

RT131156
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Fiqure 9-57  Result of Find in Help Topics Window
Help Topics: 850chelp
Eu:untent&] Index  Find l

1 Type the ward(z) vou want ta find

2 Select zome matching words to narow pour search

Clzar

Optionz...

|
-]
—

Bebuild...

L.

3 Click a topic, then click Display
; ng the Ok Cellular Phone

ACU Alarm Tab

AL Alarmz Setting Tab
AC1 DC Yolkage Alarm Threshold Tab

ACU 10 Controlz Tab

ACI /0 Descriptions T ab

ACL Meazurement T ab ﬂ

|?? Topicz Found | | All words, Begin, Auto, Pauze |

Dizplay | | Cancel |

RT131157

9.26.6 Exiting RepeaterNet

To exit RepeaterNet, return to the File menu in the Main Control screen, and select Exit.
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10.0

10.1

Link Engineering Considerations

10.0.1 Ensuring Adequate Isolation for a Repeater Application
Compare the maximum forward and reverse gain settings, to the available isolation.

* If the available isolation is at least 15 dB higher than the maximum gain setting, then
the repeater will operate with good stability.

* If the isolation is less than 15 dB higher than the maximum gain setting, then some
oscillation might result.

For CDMA systems, pre-oscillation begins at about 15 dB margin over gain, and becomes
very problematic at about 10 dB margin-over-gain. Therefore, you should strictly follow
the 15 dB margin-over-gain rule.

System Timing Issues

10.1.1 Worst-case Position for Active Search Window Width

This process estimates the required width setting for the active search window, to ensure
that the repeater properly covers a transition zone (between the base station and the
repeater).

The typical value required for SRCH_WIN_A=8. This value is more than sufficient for
most applications, where the repeater is less than three miles from the donor site, and the
repeater radius is two miles or less.

For a detailed description of this issue see Appendix E, System Timing Issues, Cell Radius,
Search Window Widths, and Pilot Inc, in the Repeater Engineering Handbook.
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10.1.2 Worst-case Position for Neighbor Search Window Width

This process estimates the required width setting for the neighbor search window, to
ensure that the repeater properly covers a soft hand-off zone (between the base station
and the repeater).

The worst-case position is wherever the greatest differential delay exists, between the cell
that the mobile uses for timing and a hand-off candidate cell.

NOTE: This relationship is symmetrical and reciprocal for neighboring cells, if those
cells are candidates for the donor sector. That is, the neighbor cells also need wider search
windows.

Wider search windows can search the TOA (Time Of Arrival) of the specific pilot, that is
associated with the donor sector (the pilot is accessible via the repeater).

The following equation calculates the differential delay:

A(Chips) = D+R+S-N(Chips)
Where:

A(Chips) = Differential_Delay(Chips)

D = Donor_Path_Length(Chips)

R = Repeater_Delay(Chips)

S = Subscriber_Path_Length(Chips)

N = Neighbor_Path_Length(Chips)
The typical process is:

1. Determine the place where the differential delay is greatest, and where a mobile is
likely to be operating.

2. Calculate the differential delay.
This worst-case differential delay determines the SRCH_WIN_N parameter setting.

The typical value required for SRCH_WIN_N (for repeater operation in the transition
zone) is about * 40 chips. This corresponds to SRCH_WIN_N = 9. This value is more than
sufficient for most applications, where the repeater is less than three miles from the donor
site, and the repeater radius is two miles or less. For a detailed description of this issue,
see Appendix E, System Timing Issues, Cell Radius, Search Window Width, and Pilot Inc,
in the Repeater Engineering Handbook.

10-2
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10.1.3 Channel Search Window Width for Reverse Link Access

The mobile station searches the forward link TOA probability space, for new pilot offsets.
A similar search process occurs at the base station.

The base station modem chip (CSM) also contains a searcher. Both the access channel and
the traffic channel use this searcher, to determine the TOA of the mobile's energy. Because
the access channel does not know how far an originating mobile is form the base station,
it must search the entire TOA probability space associated with the cell's maximum
radius.

For example, if the cell has a maximum radius of 20 chips, then the searcher must search
the range of relative TOA, from near zero chip delay (for very close mobiles), to delays as
great as 40 chips.

NOTE: The round trip delay is the important variable, because the mobile is "phase
locked" to the PN sequence of the down-link (forward link) path. Also, the TOA (round-
trip delay) of the base station, is twice the one-way delay.

The cell radius plays a central role in determining the required width for the access-chan-
nel search window. Most CDMA network manufacturers derive all of the required search
window parameters from a simple parameter, called Cell_Radius or something similar.
Usually, if you set this parameter to the maximum cell radius, the Link Engineering
Spread Sheet (LESS) automatically calculates and updates all corresponding parameters
(such as preamble size, PROBE_RAN_N, and so on).

NOTE: You must set this parameter properly. An incorrect setting can limit the range of
access, to the base station, via the repeater.

The setting for this parameter is simply the sum of the donor link radius, the repeater
delay in miles, and the maximum repeater coverage range, as shown in the following
equation:

Cell_Radius(miles) =
Donor_Path_Length(miles)+[Repeater_Delay(us)]*0.186+Repeater_Radius(miles)

If the equipment manufacturer does not provide a Cell Radius type parameter, or if you
need more information on this subject, refer to the Reverse Search Window Overview
document. The Repeater Technologies Application Engineering Group can also address
issues such as this.
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10.1.4 Setting Radius of Traffic Channel Search Window

The new base station must acquire the reverse traffic channel during a soft hand-off
attempt. The search process is similar to the one that the access channel performs during
initial system access.

The Primary Base Station (initial base station) receives the Pilot PN Phase information in
the Pilot Strength Measurement Message. You can use this information to estimate the
Time of Arrival (TOA) at the new base station. This can significantly reduce the acquisi-
tion time of the reverse traffic channel. Due to the dynamic nature of the mobile propaga-
tion environment, and the delay associated with hand-off processing, the search window
must be wider than a single-point Time of Arrival (TOA) set. Typically, the reverse traffic
channel search window centers around the estimated TOA, and its width depends on
two factors:

* The accuracy of the TOA estimate.

* The maximum expected variation of the TOA, during hand-off processing.

If the CDMA equipment manufacturer uses the Pilot PN Phase to estimate the TOA at the
neighbor base station, then the search window width needs to be only a few ten-of-chips
wide (+/- 20 chips). This is typically the case; however, some manufacturers might not
use the Pilot PN Phase data to estimate the TOA.

If the TOA estimate is not available for the neighboring base station, then you must run a
complete search of all possible Times of Arrival, just as you do during the access channel
search process. In this case, the search process takes longer, and therefore the hand-off is
slower. The required width of he search window, used in this process, depends on the
TOA of the mobile's energy, at the new base station.

The equation that calculates the TOA is similar (but not identical to) setting the neighbor
search window:

TOA(Chips) = D+R+S+N(Chips)

Where:
TOA(Chips) = Differential_Delay(Chips)
D = Donor_Path_Length(Chips)

R = Repeater_Delay(Chips)
S = Subscriber_Path_Length(Chips)
N = Neighbor_Path_Length(Chips)

After the equation calculates the worst-case TOA, you can set the search window width
accordingly.
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10.2

10.1.5 Updating MTSO Data Base, Using New Timing Parameters

After you determine all of the parameters, you can update both the Mobile Telephone
Switching Office (MTSO) data base, and the repeater data base, using the proper parame-
ters. Do not perform this update, until you are ready to activate the repeater.

Drive Testing Requirements

10.2.1 Collecting Data
To ensure proper repeater operation, drive test all of the following areas:

* Repeater Coverage area.

* Transition zone, between the donor base station coverage area, and the repeater cov-
erage area.

* Soft hand-off zones, between the repeater and adjacent cell sites.

For CDMA networks, RTI recommends that you accumulate data for both the forward
and reverse link, at the same time. Usually, this requires invoking "call trace," or some
similar function within the switch. Once invoked, the switch logs the test call by time
stamp. You can later correlate this to the forward link data.

This method helps you to more-accurately analyze the link balance, and to identify areas
of high RFER and/or high Mobile_TX parameters.

10.2.2 Collection Equipment

The minimum equipment required for drive testing is:

CDMA phone.

Serial data cable.

* Laptop or notebook computer, running collection software.

* GPS receiver.
This equipment is available from a variety of sources, such as:

* Qualcomm, Incorporated.
* Safco.

* Grayson.

LCC, Inc.

Berkeley Veritronics.

Analyzing the drive test results might require a change in network timing parameters,
and/or adjustment of the repeater subscriber antenna. That is, you must optimize
repeater, using the same methods as you use for a base station.
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Reviewing Technical Specifications

11.0 RC1920C Specifications

Table 11-1 ~ Table Inputs and Outputs
Local I/O Output Type Local I/O Output Type Local I/O Output Type
Critical Alarm | Form C Relay | Remote Control | Form C Relay External Battery | Analog (DC Volts)
Relays (2) Monitor
Major Alarm Form C Relay | Digital Outputs | Opto-Isolated BUPS Monitor 6 Alarms
@) TTL
Minor Alarm Form C Relay | Digital Inputs Opto-Isolated
@) TTL
Table 11-2  Additional Characteristics
Waveform Spurious 3dB SAW Delay Maximum VSWR | Noise Figure
Quality Factor Response Filter Input Signal
Degradation Bandwidth (without
(rho) damage)
p>0.95 per IS-95/15-97 | <1.27 MHz <6 msec | +10 dBm <151 <6 dB per path
Table 11-3  RepeaterNet Alarm, Monitoring, and Control
Access Options GUI Functions
e RS-232 (local) Windows 95/NT * Summary Alarm
* POTS (dial-up) (craft) * Interrupt Reporting
e Wireless Modem Windows NT (NMS) | ¢ Definable Threshold
32-bit * Remote Control: Gain,
Point-and-click Channel, PA On/ Off
Wireless Modem
550-3100-01 Rev A 11-1
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Table 11-4  Alternate Power Options

Type Description
BUPS 2-8 hours of backup power, without AC
Solar Power PV (Photovoltaic), with regulated charging batteries
Hybrid Solar and TEG PV, with thermal electric propane generation assistance
Hybrid Solar and MG PV, with propane or diesel generation assistance

11.1 RC1900C Specifications

Table 11-5  Frequency Range Options (MHz)

Block Bandwidth Reverse Forward
A 15 1850-1865 1930-1945
B 15 1870-1885 1950-1965
C 15 1895-1910 1975-1990
D 5 1865-1870 1945-1950
E 5 1885-1890 1965-1970
F 5 1890-1895 1970-1975

Table 11-6 Electrical Characteristics

RF Output Per Carrier at the Antenna Port
Link 1-Channel 2-Channel Gain (dB
Forward +38 dBm +38 dBm 65-95
Main Reverse +18 dBm +18 dBm 65-95
Diversity Reverse +18 dBm +18 dBm 65-95

Table 11-7 Mechanical/Electrical Characteristics

Power Consumption Size Weight Input Temperature Antenna
Voltage Connectors
Options
1-channel | 310 Watts 16Hx14Wx <501~or 110/230 -40° to 55° Type N (f)
11.5D (inches) 23 Kg. VAC or ambient 7/16 DIN (f)
406Hx356Wx +24/28 optional
292D (Mm) VDC
2-channel | 570 Watts (total)
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Table 11-8 ~ AC and DC Electrical Power Characteristics
Power Type Voltage Current (typical) Current (typical)
1-channel 2-channels
AC 100 to 264 Colts 1.75 Amps @177 VAC 0.95 | 3.0 Amps @ 117 VAC 1.6
(auto-ranging) Amps @ 230 VAC Amps @ 230 VAC
DC 22 to 32 Volts 7.5 Amps @ 24 VDC 12.8 Amps @ 24 VDC

NOTE: For solar-power applications, if the repeater is not handling CDMA traffic (only
paging, pilot, and sync channels), it enters Power-Save Mode, reducing power consump-

tion by 20%.
Table 11-9  Additional Characteristics
Waveform Spurious 3dBSAW | Group | Maximum | VSWR | Noise Figure
Quality Factor | Response Filter Delay Input
Degradation Bandwidth Signal
(rho) (without
damage)
P>0.95 Per ANSI <1.27 MHz <6émsec | +10dBm <151 <6dB per path
J-STD-008
Table 11-10  RepeaterNet Alarm, Monitoring, and Control
Access Options GUI Functions
e RS-232 (local) * Windows 95 Craft * Summary Alarm
e POTS (dial-up) * Windows NT (NMS) * Interrupt Reporting

¢  Wireless Modem

32-bit Point-and-click

¢ Definable Threshold

¢ Wireless Modem ¢ Remote Control: Gain, Channel and PA
On/ Off
Table 11-11  Alternate Power Options
Type Description
BUPS 2-8 hours of backup power, without AC

Solar Power

PV (Photovoltaic), with regulated charging batteries

Hybrid Solar and TEG

PV, with thermal electric propane generation assistance

Hybrid Solar and MG

PV, with propane or diesel generation assistance
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Table 11-12  Inputs and Outputs
Local I/O Output Type Local I/O Output Type Local I/O Output
Type
Critical Alarm | Form C Relay | Remote Control Form C Relay External Analog:
Relays (2) Battery Monitor DC Volts
Major Alarm Form C Relay | Digital Outputs (2) | Opto-isolate TTL | BUPS Monitor 6 Alarms
Minor Alarm Form C Relay | Digital Inputs(2) Opto-isolate TTL
Table 11-13  Table LED Indicators
System Ready

Critical Alarm

Minor Alarm

Major Alarm
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11.2 Ordering Information

The tables that follow provide information about ordering from Repeater Technologies,

Inc.; specifically:

* Ordering Considerations

Back-up Power Systems (BUPS)

* Accessory Kit Items

Repeater Configurations and Part Numbers

Optional Equipment Available from Repeater Technologies

When ordering, specify a shipping destinations and a billing address. Repeater Technolo-
gies will return an order acknowledgment, and the scheduled shipping date. Each ship-

ment includes an equipment list, showing the equipment ordered, and the equipment

shipped. This list includes details about system equipment options. Contact the Repeater
Technologies Sales Department for ordering information.

Table 11-14  Spare parts and Accessory Items
Description Part Number
Antennas* Call for information
Connectors Call for information
Coaxial Cable Call for information
AC Power Cord 103-0137-01
Pole Mounting Kit 137-0438-01

McMaster-Carr ¥s-inch Banding Kit

Part No. 5653K12, McMaster-Carr Supply Co.,
Los Angeles, CA, USA, Tel.# (562) 692-5911

I/0O Entry Box Door (OA850C Only)

024-1008-01

1/O Entry Box (OA850C Only) 024-1007-01
I/ O Box Door Gasket (OA850C Only) 022-0122-01
I/ O Entry Box and Door (OA1900C Only) (024-1004-01
I/ O Box Door Gasket (OA1900C Only) 022-0127-01
1/ O Box Gasket (OA850C Only) 022-0124-01
Internal Lead Acid Back-up Battery 149-0852-01
PC Interface Cable DB9, 9-pin, Female-to-Female | 187-0713-01
Modem Module (OA850C Only) 087-1524-05
Modem Module (OA1900C Only) 087-1524-01

Wireless Interface Cable

To be announced.

BUPS-25/80

250-1011-07
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Table 11-14  Spare parts and Accessory Items (Continued)

Description Part Number

Surge Protector - N(M) to N(F) Lightning Call RTI
Operations Manual (Hard Copy) 550-5100-01
Operations Manual (CD ROM) 550-5100-02
Alarm, Power, and Growth Cabinet Button Plugs | 137-0446-01
Conduit Fitting 137-0447-01
Back Mounting Plate 020-1229-03
Stainless Steel 3/8" Locking Washer 125-0059-07
Stainless Steel 3/8" x 1" Flat Washer 125-0068-07
Stainless Steel Pin-in-Head Security Bolts 125-0212-13
Stainless Steel Hex Head Bit Pin-in-Head, 7/32 "129-0007-08
Door Hinge Set 137-0428-01
Allen Wrench 129-0007-02
RepeaterNet NMS Craft Software 519-1200-03
BUPS Power & Alarm Cable Assy (Kit) 187-0188-01

*Typical antennas include parabolic reflectors, corner reflectors, circular, linear, directional co-linears, cross
or slant polarization, log periodic array, or Yagi.

To select BUPS (Back-up Power System) for the repeater application, match the repeater
with the amount of back-up time required.

Table 11-15  Back-up Power System Selection Guide

Product Power Calculated Back-up Hours
Model Number Cogszlin&};tcion g;lrr\e;gtc BUPS-25/80
25 A 80 A-H
Oaxxx, 1-channel 260 W 108 A 7.4
Oaxxx,, 2-channel 500 W 20.8 A 3.8
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Table 11-16

Contents of AC and DC Accessory Kits, for RC1920C

AC Accessory Kit (P/N 091-0105-01) DC Accessory Kit (P/N 091-0105-02
Items Quantity Items Quantity
Power Cord 1 each BUPS Power and Alarm Cable 1 each
Assembly
Wrench, Hex Key (Allen Wrench) 1 each Wrench, Hex Key (Allen Wrench) 1 each
PC Interface Cable DB9, Female to 1 each PC Interface Cable 1 each
Female
Hex bit, Pin-in-Socket, 7/32 "1 each Hex bit, Pin-in-Socket, 7/32 "1 each
Alarm, Power, and Growth Cabinet | 4 each Alarm, Power and Growth Cabinet | 4 each
Button Plugs Button Plugs
Conduit Fitting 4 each Conduit Fitting 4 each
Operations Manual (Hard Copy) 1 each Operations Manual (Hard Copy) 1 each
RepeaterNet Craft Software 4 disks RepeaterNet Craft Software 4 disks

Table 11-17  Contents of AC and DC Accessory Kits, for RC1920C

AC Accessory Kit (P/N 091-0105-01)

DC Accessory Kit (P/N 091-0105-02)

Items Quantity Items Quantity
Power Cord 1 each BUPS Power and Alarm Cable 1 each
Assembly

Wrench, Hex Key (Allen Wrench) 1 each Wrench, Hex Key (Allen Wrench) 1 each
PC Interface Cable DBY, Female to | 1each PC Interface Cable 1 each

Female
Hex Bit, Pin-in-Socket, 7/32 "1 each Hex Bit, Pin-in-Socket, 7/32 "1 each
Alarm, Power, and Growth Cabi- 4 each Alarm, Power, and Growth Cabinet | 4 each

net Button Plugs Button Plugs
Conduit Fitting 4 each Conduit Fitting 4 each
Operations Manual (Hard Copy) 1 each Operations Manual (Hard Copy) 1 each
RepeaterNet Craft Software 4 disks RepeaterNet Craft Software 4 disks
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11.3 Technical Services

Repeater Technologies offers technical services to supplements the manpower resources
of it customers. RTI will provide3 quotations for the following services, upon request:

* Site and construction surveys

Network Design

Design Verification

* Training

Installation

* Accessories (antenna, coaxial cabling, and so on)
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Programming the Cellular Phone 1 2

12.0 Introduction

This cheaper describes how to program the Motorola Micro T.A.C. Elite II cellular phone.
This phone is installed in the Entry Box of the repeater (the Entry Box is the separate
housing attached to the bottom of the main repeater box). The cellular phone includes a
battery, but the repeater provides normal operating power to the phone.

12.1 Removing the Cellular Phone for Programming
The cellular phone is located inside the lid of the repeater's Entry Box.
To remove the cell phone unit for programming, use the following procedure.

1. Open the lid of the repeater's Entry Box.
2. Disconnect the power plug, located at the base of the phone.
3. Carefully pull the phone away from its cradle.
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12.2 Programming the Cellular Phone

1. To program the cellular phone properly, install an AC charger, and a cell phone
antenna.

2. Press the phone PWR (Power) button to turn On power to the cellular phone.
3. Press the FCN (Function) button followed by zero(0).

NOTE: The factory Default Security Code is 000000.

4. Enter the six-digit security code, twice.

5. Press the RCL (Recall) button on the cellular phone.

6. Press the star (*) button.
The program advances to the first data field for Entry 01 (System ID).
Use the keypad to enter the new data for this field.

8. Repeat Steps 5 and 6 to advance to, and to set, each subsequent data field in the pro-
gramming sequence.

Refer to Table 12-1 for the programming sequence.

9. Exit the programming mode.

*To exit the programming mode without saving changes, press the Pound (#) button.

*To save the newly-entered data, press the SND (Send) button, while on any entry

number. After the cellular phone sends all entries, the sequence wraps around to
Entry O1.

10. Press the PWR (Power) button to turn Off power to the cellular phone.
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12.3 Reinstalling the Cellular Phone, After Programming

After programming the cellular phone, use the following procedure to reinstall the unit in
the Entry Box lid.

1. Remove the cellular battery and antenna from the phone.

2. Reconnect the plug at the base of the phone.

3. Press the cell phone back into its cradle.

4. Secure the lid of the repeater's Entry Box.

Table 12-1 ~ Data Sequence Programming

Entry Standard Description
Number Default
01 00000 System ID (SID) - The five-digit number that the FCC assigns, for system
identification. "A" side is odd; "B" side is even.
02 111 Cellular Area Code - Assigned by the System Operator.
03 1110111 Cellular Telephone Number - Assigned by the System Operator.
04 XX Station Class mark
05 00 Access Overload Class
06 00 Group ID Mark
07 000000 User Security Code
08 123 Unlock Code
09 0334 Initial Paging Channel - Enter 0333 for "A" side System Ids (SIDs), and
0334 for "B" side SIDs.
10 011100 Options Programming. Binary bits (1 or 0), read from left to right.
0 Internal Speaker Disable
1 Local Use. assigned by the System Operator.
1,0,? MIN Mark.
1 Auto Recall 1=enabled.
0 Second Telephone Number Enabled.
0 Diversity 1=enabled.
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Default Alarm Settings

A.1 Introduction

Table A-1 Default Alarm Settings
Subsystem Option Alarm Default Setting
Front End Forward Fwd FE Alarm Critical
Reverse Rev FE Alarm Critical
Rev FE Protect Alarm Critical
Diversity Diversity FE Alarm Critical
Channel 1 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Disabled
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm | Disabled
Forward PA Fwd PA Alarm Critical
Fwd PA VSWR Alarm Disabled
Fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm | Disabled
PA Control Reverse PA Off
Forward PA Off
Reverse Filter CSF Rev Alarm Event
Forward Filter CSF Fwd Alarm Event
Gain Forward and Reverse 65 dB
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Table A-1 Default Alarm Settings (Continued)
Subsystem Option Alarm Default Setting
Channel 2 Reverse PA Rev PA Alarm Critical
Rev PA VSWR Alarm Disabled
Rev PA Thermal Alarm Major
Rev PA Ext Shutdown Alarm Disabled
Forward PA Fwd PA Alarm Critical
Fwd PA VSWR Alarm Disabled
Fwd PA Thermal Alarm Major
Fwd PA Ext Shutdown Alarm | Disabled
PA Control Reverse PA Off
Forward PA Off
Reverse Filter CSF Rev Alarm Event
Forward Filter CSF Fwd Alarm Event
ACU (*If the repeater uses external External Input 1* Alarm Disabled
(Alarm Control inputs or e?ternal eqqip— External Input 2* Alarm Disabled
Unit) ment, set darm severity Temperature Alarm Minor
as appropriate.)
Tamper Alarm Major
Analog Input Alarm Disabled
Ext. Growth Box Alarm Disabled
Power Supply Channel PS Input Power Critical
Power Supply Alarm Critical
Battery Alarm Minor
Backup Power AC Fail Alarm Disabled
S];PII;ISY Low Battery Alarm Disabled
(BUPS) High Battery Alarm Disabled
Charger Fail Alarm Disabled
UPS Summary Alarm Disabled
Tamper Alarm Disabled
Modem Modem Alarm Minor
Cellular Phone Cell Phone Alarm Minor
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B.1 Verifying Correct Installation

This section summarizes how to verify that the repeater is correctly installed.

Isolating the Primary Cabinet

1.

NS

8.
9.

Disconnect EVERYTHING from the RC1920C, except the Back-up Power Supply
(BUPS).

Power the repeater on.

Start the RepeaterNet software, pull down the Configuration menu, and select Hard-
ware.

Uncheck growth box, if it is checked.

Exit RepeaterNet.

Restart RepeaterNet.

Turn on the Power Amplifier (PA) gains, and make sure that everything is function-
ing.

Turn off the PAs.

Exit RepeaterNet.

This test verifies that the primary cabinet is working properly.

Testing the Primary Cabinet, with Antennas

SRS S e

Connect the antennas to the repeater, one at a time.

Start the RepeaterNet software, and make sure that no alarms are currently reported.
Turn on the PAs, and adjust gains.

Turn off the PAs.

Exit RepeaterNet.

Disconnect the antennas

This test verifies that the primary cabinet and antennas are working properly.
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Isolate the Primary and Growth Cabinet
Follow these steps when isolating the primary cabinet from growth cabinet.

1. Connect the Growth Cabinet to the Primary Cabinet.

Power on ONLY the Primary Cabinet, and ensure that the connector is at +24 Volts
DC.

3. With the multimeter still monitoring +24VDC, turn on the Growth (secondary chan-
nel) Cabinet.

4. If all is well, place the meter on the BUPS amps test port, and monitor the current.
5. Set the multimeter for "mV" range. On the BUPS, ImV =1 AMP.

6. Start the RepeaterNet software, pull down the Configuration menu, and select Hard-
ware.

Check the growth box selection.
8. Exit RepeaterNet.
Restart RepeaterNet, and check for secondary-channel function.

If there is no growth box function, check +24 VDG, at the input to the second chan-
nel, then check the ribbon cable for reverse-polarity. Finally, repeat Step 6.

10. Turn on the PAs (without antennas), and monitor the multimeter to ensure that the
current is still within normal limits.

Note: The BUPS is designed for 25 AMPS.
11. Turn off the PAs.

This test verifies that the primary and growth cabinets are working properly.

Loaded Test
1. Connect the antennas.

2. Turn on all Power Amplifiers (PAs).
3. Monitor the BUPS current.

NOTE: The following error conditions might occur during these tests:

1. One or both channels are oscillating, drawing more current than the BUPS can provide.
If this occurs, turn PAs off, and check whether DC power returns to both repeater units.

2. The antenna cables might be shorted, causing the PA to draw more current than the
BUPS can provide. If this occurs, disconnect antennas, and ohm out the connectors.

3. The BUPS has failed. It cannot handle the load of both the Primary and Growth
cabinets.
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B.2 Verifying Correct Operation

This section describes some of the problems that you might encounter while operating
the RepeaterNet system. The steps listed (to resolve the problem) might not include all of
the possible reasons for non-operability, but this information is provided to assist you in
identifying the actual difficulty. The problem attributes in the following paragraphs are in
descending order, starting with the most likely problem listed first.

If the repeater continues to have problems, call Repeater Technologies Customer Support
for assistance. See the front cover of this manual for current telephone numbers.

Problem 1 RepeaterNet reports that it cannot open the database.

Either the Data Source Name (DSN) is configured improperly, the DSN does not point to
the proper location, or the system did not find the DSN itself. Call Customer Support for
assistance.
* The correct DSN or User ID is not identified.
* The Windows Open DataBase Connectivity (ODBC) drivers are not installed.
* The database file, to which the DSN points, is corrupted, or needs repair.
Problem 2 RepeaterNet reports that it cannot read the database Ports table

You have not configured the ports, in the system database.
The Ports table in the database might be corrupted. Repair the database and retry.

Problem 3 The System starts up without error, but when you launch a repeater graphical user interface,
no detailed data appears.

Wait for up to 4 minutes (the maximum time required to complete a cell modem connec-
tion), to determine whether the program can connect to the repeater. If the program can-
not connect, a warning pops-up after 4 minutes, indicating that RepeaterNet could not
establish communications.

Problem 4 A specific port does not seem to be in use, and an Alert exists. Or the database log reports the
error "Unable to initialize port COMn", where n designates the non-functioning port.

You configured the port number incorrectly, or the port does not exist.

The port is assigned to another program, operating in the same PC. Windows does not
permit two active programs to share a communications port. Shut down the other pro-
gram.
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Problem 5 The system reports "Unable to connect to repeater..."
This error message can indicate any of the following:

* The cellular carrier is not handling the call.
* The phone number that you provided is incorrect, or is out of service.
* The modem or phone line has a problem.
* The repeater itself has a problem.
Problem 6 The system reports the message "An unsupported operation was attempted."

This message appears if the installation failed to register the Object Linking and Embed-
ding (OLE) controls, for alarm bitmaps.

Problem 7 RepeaterNet conflicts with Microsoft Fax.
To disable the Microsoft Fax auto answer mode:

Open the mail icon from the Microsoft Control Panel.
Select Microsoft Fax from the Services tab.

Click on the Properties button.

Select either the Manual or the Don't answer radio button.
Click the OK button, to save this change.

S N
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B.3 Verifying Primary and Secondary Channel
B.3.1 Test Equipment

Table B-1 lists the test equipment and tools required for verifying both traffic channels.
You can use equivalent substitutes for the tools listed here.

Table B-1 Test Equipment for Channel Verification Tests

Item Tests
Voltmeter, Fluke 75 Power System, Analog Test Points
Power Meter, HP 435B with 8481 Sensor Power Output
Spectrum Analyzer, HP 8560 series, capable of up to 2 GHz Power Output
Type N (male) 50-Ohm Termination, 20W, (2 ea.) Power Output

Signal Generator, capable of generating CW signal of +10 dBm or Power Output
greater, at 800 MHz or greater frequencies

Laptop computer RepeaterNet configurations
Type N (m) 30 dB pad, or bi-directional 30 dB coupler Power Output

Open End Wrench or Spanner, 5/16 inch (1 ea.)* Power Monitor, Maintenance
Screwdriver, 1/4 inch, 6 mm blade* Wiring, Maintenance
Screwdriver, #1 Phillips Wiring

* Not supplied with Growth Box.

B.3.2 Applying Power

1. Terminate the antenna ports on the Repeaters, using Type N (male) 50-ohm Termina-
tions.

2. Connect the laptop to the repeater.
3. Apply power to the Primary Cabinet, either AC or DC, as required.

4. Check that both the Critical LED and the Minor LED (on the entry panel of the Main
Repeater) are ON.

NOTE: When Repeater Technologies ships the repeater from the factory, the Forward PA
(Power Amplifier) and Reverse PA are both in the OFF position. The standby battery
(located inside the Entry Panel) is disconnected.

5. Connect the red battery lead to the standby Lead Acid battery.
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B.3.3 Measuring Voltage

Measure the AC or DC voltage, at the J3 connector in the Entry Panel, to verify the proper
voltage.

B.3.4 Measuring the Output

This section covers the testing required, to determine proper operation of the Repeater
and the Growth Box.

1. Start the RepeaterNet software.

NOTE: You must use RepeaterNet Craft Admin program to configure the connection to
the Repeater and Growth Box before accessing the RepeaterNet Craft software.

2. Select Configuration/ Hardware Setting from the RepeaterNet menus, to ensure that
the Growth-Box configuration is enabled (see Figure B-1).

Figure B-1 ~ Hardware Setting Screen

Hardware Setting

r— GrawathB ox Configuration

¥ GrowthBios is attached

r Modem Configuration

I Modem iz attached

r Cellular Phone Configuration

[ Cellular Phane iz attached

Cancel |

3. Check the "Growth-Box is attached" box, and click the OK button

4. Select Configuration/Channel 1 from the RepeaterNet menu, and select the Channel
# tab to display and set the operating channel.
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Fiqure B-2  Channel Properties Screen, Channel # Tab

Channel 1 Properties

Rev. P& | Fid P& | PA Contiol | Rev. Fier | Fwd Fiter Channel# | Gain |

Charnel Mumber
Fonward Frequency [MHz) 193250
Reverse Frequency [MHz] 185250
Finimum Channel 25
Mawimum Charinel 293
Channel Spacing (KHz) a0

oK | Cancel |

RT130169

5. After selecting a channel #, click the Apply button.

RepeaterNet displays the corresponding frequencies. Record these frequencies; you
will use them when you set up the Signal Generator.

6. Select Configuration/Channel 2 from the RepeaterNet menu, and select the Channel
# tab to display and set the operating channel.

7. After selecting a channel #, click the Apply button.

RepeaterNet displays the corresponding frequencies. Record these frequencies; you
will use them when you set up the Signal Generator.

8. Verify that the Reverse Power Amplifier is OFF, using the Rev PA tab in the Channel
Properties window for both channel 1 and channel 2 (as shown in Figure B-3).
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Fiqure B-3 ~ Channel Properties Screen, Reverse PA Tab

Channel 1 Properties
Fiev. PA | Fuud. P4 | P& Contrel | Rev. Fiter | Find. Fiter | Channel # | Gain |
Alarm Description I Severty |
RewvPiad Alam Iimar A
RevPal Thermal Alarm I ajor A4
RevPiad Ext Shutdown Alam Dizabled -

aK | Cancel I Apply ‘
RT130170

9. Verify that the Forward Power Amplifier is OFF, using the Fwd PA tab in the Chan-
nel Properties window for both channel 1 and channel 2 (as shown in Figure B-4).

Figure B-4  Channel Properties Screen, Forward PA Tab

Channel 1 Properties
Rew P4 Fod P4 | P4 Control | Rev. Fiter | Fund. Fiter | Channel # | Gain |
Alarm Description I Severty |
FwdPad Alarm Minor d
FrdPad Thermal Alarm I ajor -
FwdPad Est Shutdawn Alarm Dizabled -
’Tl Cancel &pply

RT130171
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10. Using the Gain tab in the Channel Properties screens for both Channels 1 and 2, set
the channel gains to the minimum setting of 65 dB.

Fiqure B-5 ~ Channel Properties Screen, Channel Gain Tab

Channel 1 Properties
Rew. P4 | Fud P4 | P4 Control | Rev. Fiter | Fud Fiter | Channel # Gain |
Fonmard
é5 dB 95 dB
95
Reverze
B5 dB 95 dB
95
ak. | Cahicel
RT130172
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B.3.5 Verifying Forward Power Out, Channels 1 and 2

Configure the test equipment as shown in Figure B-6.

Fiqure B-6  Configuration for Measuring Forward Path Power

Subscriber
Antenna
Donor
Antenna

Signal
Generator

H

Diversity Repeater
Receive Port

Donor Antenna
<+—— Port

Tx/Rx Main
(subscriber)

Port j

Directional

Coupler

Spectrum

30 dB Analyzer

RT111903

1. Ensure that the Forward PA (Power Amplifier) is turned OFF for both the repeater
and the Growth Cabinet.

2. Set the Signal Generator to the channel 2 forward frequency, to verify that the second
(growth cabinet) channel works.

3. Set the Signal Generator output level to -56 dBm.

4. Configure the Spectrum Analyzer so that the measurement includes the 30 dB atten-
uation of the coupler.

5. Using the RepeaterNet software, ensure that the repeater channel frequency corre-
sponds to the Signal Generator frequency:.
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Setting the Channel Gain to 95 dB

Perform the following procedure for both Channels 1 and 2.

1.

In RepeaterNet, select Configuration, Channel 1 and 2.

The Channel Properties window opens.

Click the Gain tab

Click and drag the Forward horizontal sliders, until they are set to 95 dB
The gain value box (centered under the slider) displays the selected gain.
Click the Apply button.

The Apply button sets the gain.

Click the OK button.

The OK button closes the window.

Turning On the Forward Power Amplifiers

1.

In RepeaterNet, select Configuration, Channel 1 and 2.
The Channel Properties window opens
Click the PA Control tab.

The PA Control tab provides a switch to turn Power Amplifier (PA) power either ON
or OFF

Click on the value in the Forward PA box, to change the value to ON.
Click the Apply button.

The Apply button turns on Forward PA power

Click the OK button.

The OK button closes the window.

Measuring Forward PA Power

1.

Observe the Spectrum Analyzer display. The amplitude of the signal should be +38.5
dBm, to within +0.5 dB.

Turn off the Forward PAs.
Set the Forward Channel Gain to 65 dB.
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B.3.6 Verifying Reverse Power Out, Channels 1 and 2

Configure the test equipment as shown in Figure B-7.

Fiqure B-7  Configuration for Measuring Reverse Path Power.

|

Subscriber
Antenna
Donor
Antenna
0 0
Signal
Generator
Diversity Repeater
Receive Port
. Donor Antenna
Tx/Rx Main <«—— Port
(subscriber)
L Port J

J

Spectrum
Analyzer

C

S

J RT111902

1. Ensure that the Reverse PA (Power Amplifier) is turned OFF, for both the repeater

and the Growth Box.

2. Set the Signal Generator to the channel (1 or 2) forward frequency.

3. Set the Signal Generator output level to -77 dBm.

4. Configure the Spectrum Analyzer, so that the measurement includes the 30 dB atten-

uation of the coupler.

5. Using the RepeaterNet software, ensure that the repeater channel frequency corre-

sponds to the Signal Generator frequency.
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Setting the Channel Gain to 95 dB
Perform the following procedures for both Channel 1 and 2.

1. In RepeaterNet, select Configuration, Channel 1 and 2.
The Channel Properties window opens.
2. Click the Gain tab.
3. Click and drag the Reverse horizontal sliders, until they are set to 95 dB.
The gain value box (centered under the slider) displays the selected gain
4. Click the Apply button.
The Apply button sets the gain.
5. Click the OK button.
The OK button closes the window.

Turning On the Reverse Power Amplifiers

1. In RepeaterNet, select Configuration, Channel 1 and 2.
The Channel Properties window opens.
2. Click the PA Control tab.

The PA Control tab provides a switch to turn Power Amplifier (PA) power either ON
or OFF.

3. Click on the value in the Reverse PA box, to change the value to ON.
4. Click the Apply button.

The Apply button turns on Reverse PA power.
5. Click the OK button.

The OK button closes the window.

Measuring Reverse PA Power

1. Observe the Spectrum Analyzer display. The amplitude of the signal should be +18
dBm, to within +0.5 dB.

2. Turn off the Reverse PAs, and set the Reverse Channel Gain to 65 dB.

B.3.7 Concluding the Test
1. Exit the RepeaterNet software.
2. Turn off power to the repeater.

3. Disconnect the Spectrum Analyzer, the pad or coupler, and the Signal Generator.
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Glossary

This glossary defines communications industry acronyms, symbols, and terms. Hard-
ware-related and software-related acronyms are also included. Because this glossary sup-
plements all operations manuals from Repeater Technologies, not all items listed here
necessarily appear in this manual.

A
Acu
Alc
Amps
Api

Back-beam

Bnc
Bts
Bups
Cdma
Cle
C/i

Cpc
Crc
Csm

Damps

Amp or Amps.

Alarm Control Unit.

Automatic Level Control.
Advanced Mobile Phone System.
Application Programming Interface.

A back-beam antenna transmits energy backward, towards the donor BTS. This increases the
allowable distance between the donor BTS and repeater sites, in CDMA networks.

Type of connector.

Base Transceiver Station.
Back-Up Power Supply.

Code Division Multiple Access.
Carrier-to-Echo Ratio.

Carrier-to-Interface Ratio. The ratio between the mean signal level of the desired radio signal,
and the signals from other (interfering) sources. Typically expressed in dB.

Circular Plastic Connector.
Cyclical Redundancy Check.
Cell Site Modem.

Digital Advanced Mobile Phone System (equivalent of TDMA).
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Darlington Pair

DB
DBC
DBi
DBm
Df, Dfb
Donor
Dsn
Dvm
Em
Emi
Erp
E/b
Fcc

Fe
Fifo

Forward Direction

Forward Gain
Fru
Fsk

Gain

Gsm
Gui
Hand-off

Hbw

Two transistors, arranged so that the emitter of one drives the base of the other, and connects
the collectors together. The result is an increase in gain compared to a single transistor,
because the gains of the two transistors are multiplied together. The trade-off for this
increased gain is reduced speed, because of the very high gain's effect on the collector-to-base
capacitance. You can use this pair of transistors as a single transistor: common emitter, emit-
ter follower, and so on.

Decibel or decibels.

Decibels, referenced to the carrier level.

Decibels, referenced to the isotropic antenna.

Decibels, referenced to one milliwatt.

Distributed Feedback (Laser).

An antenna that communicates between a repeater and a BTS.
Data Source Name. A name that represents the database file (or connection).
Digital Voltmeter.

Electromagnetic.

Electromagnetic Interference.

Effective Radiated Power.

Front-to-Back Ratio.

Federal Communications Commission (USA).

Front End.

First In First Out.

Direction of transmission from the base station, through the Repeater, and on to Mobile or
hand-held units. Downlink transmission.

Gain setting for Forward (downlink) transmissions.
Field Replaceable Unit
Frequency-Shift Keying.

Number of decibels by which a repeater amplifies an audio (speech) signal, when transmit-
ting it to (reverse gain) or from (forward gain) a base station (BTS).

Global System for Mobile Communications, or Groupe Speciale Mobile.
Graphical User Interface.

On a cellular system, the act of transferring a call in progress, from one cell or sector to
another. Typically also involves changing to a different voice channel.

Horizontal Beam Width of an antenna.

C-2
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Hot Tone

Hpp
If
Im
Imd
Led

Less

Lna

Lo

Los
Microcell

Morphology

Mprl
Msc
Mtso

Multipath

Nim

Odbc

Ole

Otu

Pa

Paging Channel
Pep

If a Mobile transmits at full power in close proximity to a receive antenna, a hot tone — for
example, a receive signal above -40 dBm —is produced. Too hot a tone can over-modulate a
system, and force it to drop all calls. If a system is designed to control reverse attenuation, it
can moderate the potentially-damaging effect of hot tones.

Half Power Point of an antenna.
Intermediate Frequency.
Intermodulation.
Intermodulation Distortion.
Light-Emitting Diode.

Link Engineering Spread Sheet. Controls signal noise and gain between the base transceiver
station (BTS) and the repeater.

Low Noise Amplifier.

Local Oscillator, high-level input into mixer.
Line-Of-Sight.

Any small, low-power cell site.

The structure (layout) of the repeater coverage area. Morphology factors include natural sig-
nal-path obstructions (trees and hills), man-made obstacles (buildings and billboards), dis-
tance between the repeater and the base station, number of cell-phone users within the
repeater coverage area, and coverage inside buildings and tunnels.

Maximum Power radiation Limit of an antenna.
Mobile Switching Center (equivalent to MTSO).
Mobile Telephone Switching Office (equivalent to MSC).

Radio propagation between a transmitter and receiver, where the received signal contains
multiple rays. Each ray has undergone one or more reflections and/ or refractions. Cellular
coverage is usually multipath, especially in high-density city areas.

Noise Injection Margin. The amount of noise (dB) that a repeater injects into the CDMA air
interface.

Network Repeater.

Open DataBase Connectivity. An Application Programming Interface (API) in Windows, that
lets a programmer abstract a program from a database.

Object Linking and Embedding. Integrates applications, and permits copying objects from
one application to another. Uses the first application’s editing techniques, when editing a
copied object in the second application.

Optical Transceiver Unit.
Power Amplifier.
Passes parameters over a CDMA network, during operation.

Peak Envelope Power.
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Pilot Channel
Pll

Pstn

Qccb

Rbs

Reverse Direction

Reverse Gain
Rf

Rfi

Rma

Rot

Rpe

Rsl

Rsa

Rssi

Rti

Rx

Sid
Simulcast
Sma

Smb

Subscriber

Sync Channel
Tdma

Traffic Channel
Tsa

Tx

Ucu

Uhf

Ups

Measures power, and performs initial synchronization, over a CDMA network.
Phase Locked Loop.

Public Switched Telephone Network.

Quick-Connect Connecting Block.

Radio Base Station. See also BTS.

Direction of transmission from the Mobile or portable, through the repeater, and on to the
RBS. Uplink transmission.

Gain setting for Reverse (uplink) transmissions.
Radio Frequency.

Radio Frequency Interference.

Returned Materials Authorization. Issued before you return a repeater to RTI for upgrading.

Rise Over Thermal. The amount of increase in noise level (dB) at the BTS, that the repeater
creates.

Radiation Pattern Envelope. Defines the attenuation of side-lobe energy from an antenna.
Receive Signal Level.

Rural Service Area.

Receive Signal-Strength Indicator.

Repeater Technologies, Inc.

Receive.

System ID. A five-digit number that the FCC assigns for system identification.

The process of transmitting the same signal from two or more sites simultaneously.

A type of connector.

A type of connector.

An antenna that communicates between a repeater, and either a cellular phone or another
repeater.

Passes parameters, during initial synchronization of a CDMA network.
Time Division Multiple Access (equivalent to DAMPS).

Carries communications traffic over a CDMA network.

Traffic Service Area.

Transmit.

Universal Control Unit.

Ultra High Frequency.

Uninterruptable Power Supply. The BUPS is a type of UPS.

C-4
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A\ Volt or Volts.

Vac Voltage, Alternating Current.

Vdc Voltage, Direct Current.

Vocoder A vocoder, or voice coder, divides speech signals into various bands of the audio spectrum,

compresses and encrypts the resulting audio segments, and transmits the digitized speech
over a cellular (wireless) network. The cellular phone (receiver) decrypts, decompresses, and
reassembles the transmitted audio segments, to sound like normal (analog) speech again. To
receive and retransmit speech signals between base stations (BTS), an RTI repeater needs to
know the transmission rate and frequency that the vocoder uses on the specific cellular net-
work. Use the Link Engineering Spreadsheet (LESS) to report this information to the repeater.

Vswr Voltage Standing Wave Ratio.
W Watt or Watts.
Xpd Cross Polarization.
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